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Safety Information
The information provided in this documentation contains general
descriptions and/or technical characteristics of the performance of the
products contained herein. This documentation is not intended as a
substitute for and is not to be used for determining suitability or reliability
of these products for specific user applications. It is the duty of any such
user or integrator to perform the appropriate and complete risk analysis,
evaluation and testing of the products with respect to the relevant specific
application or use thereof. Neither Schneider Electric nor any of its
affiliates or subsidiaries shall be responsible or liable for misuse of the
information contained herein. If you have any suggestions for
improvements or amendments or have found errors in this publication,
please notify us.
No part of this document may be reproduced in any form or by any
means, electronic or mechanical, including photocopying, without express
written permission of Schneider Electric.
All pertinent state, regional, and local safety regulations must be
observed when installing and using this product. For reasons of safety
and to help ensure compliance with documented system data, only the
manufacturer should perform repairs to components.
When devices are used for applications with technical safety
requirements, the relevant instructions must be followed. Failure to use
Schneider Electric software or approved software with our hardware
products may result in injury, harm, or improper operating results.
Failure to observe this information can result in injury or equipment
damage.
© 2011 Schneider Electric. All rights reserved.
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Safety Information

Read these instructions carefully, and look at the equipment to become
familiar with the device before trying to install, operate, or maintain it. The
following special messages may appear throughout this documentation or
on the equipment to warn of potential hazards or to call attention to
information that clarifies or simplifies a procedure.
The addition of this symbol to a Danger or Warning safety
label indicates that an electrical hazard exists, which will
result in personal injury if the instructions are not followed.
This is the safety alert symbol. It is used to alert you to
potential personal injury hazards. Obey all safety messages
that follow this symbol to avoid possible injury or death.

DANGER
DANGER indicates an imminently hazardous situation which, if not
avoided, will result in death or serious injury.
WARNING
WARNING indicates a potentially hazardous situation which, if not
avoided, can result in death or serious injury.
CAUTION
CAUTION indicates a potentially hazardous situation which, if not
avoided, can result in minor or moderate injury.
CAUTION
CAUTION used without the safety alert symbol, indicates a potentially
hazardous situation which, if not avoided, can result in equipment
damage.
PLEASE NOTE
SCADAPack Vision User Manual 11/10/2011
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Electrical equipment should be installed, operated, serviced, and
maintained only by qualified personnel. No responsibility is assumed by
Schneider Electric for any consequences arising out of the use of this
material.
A qualified person is one who has skills and knowledge related to the
construction and operation of electrical equipment and the installation,
and has received safety training to recognize and avoid the hazards
involved.
BEFORE YOU BEGIN
Do not use this product on machinery lacking effective point-of-operation
guarding. Lack of effective point-of-operation guarding on a machine can
result in serious injury to the operator of that machine.
CAUTION
UNINTENDED EQUIPMENT OPERATION
•

Verify that all installation and set up procedures have been
completed.

•

Before operational tests are performed, remove all blocks or other
temporary holding means used for shipment from all component
devices.

•

Remove tools, meters, and debris from equipment
Failure to follow these instructions can result in
death, serious injury or equipment damage.

Follow all start-up tests recommended in the equipment documentation.
Store all equipment documentation for future references.
Software testing must be done in both simulated and real environments.
Verify that the completed system is free from all short circuits and
grounds, except those grounds installed according to local regulations
(according to the National Electrical Code in the U.S.A, for instance). If
high-potential voltage testing is necessary, follow recommendations in
equipment documentation to prevent accidental equipment damage.
Before energizing equipment:
•

Remove tools, meters, and debris from equipment.

•

Close the equipment enclosure door.

•

Remove ground from incoming power lines.

•

Perform all start-up tests recommended by the manufacturer.

SCADAPack Vision User Manual 11/10/2011

8

Safety Information
OPERATION AND ADJUSTMENTS
The following precautions are from the NEMA Standards Publication ICS
7.1-1995 (English version prevails):
•

Regardless of the care exercised in the design and manufacture of
equipment or in the selection and ratings of components, there are
hazards that can be encountered if such equipment is improperly
operated.

•

It is sometimes possible to misadjust the equipment and thus produce
unsatisfactory or unsafe operation. Always use the manufacturer’s
instructions as a guide for functional adjustments. Personnel who
have access to these adjustments should be familiar with the
equipment manufacturer’s instructions and the machinery used with
the electrical equipment.

•

Only those operational adjustments actually required by the operator
should be accessible to the operator. Access to other controls should
be restricted to prevent unauthorized changes in operating
characteristics.
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About The Book

At a Glance

Document Scope
This manual describes the SCADAPack Vision installation, programming
and maintenance.
Validity Notes
This document is valid for all versions of the SCADAPack Vision.
Product Related Information

WARNING
UNINTENDED EQUIPMENT OPERATION
The application of this product requires expertise in the design and
programming of control systems. Only persons with such expertise
should be allowed to program, install, alter and apply this product.
Follow all local and national safety codes and standards.
Failure to follow these instructions can result in death, serious
injury or equipment damage.
User Comments
We welcome your comments about this document. You can reach us by
e-mail at technicalsupport@controlmicrosystems.com.
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The SCADAPack Vision is compact, panel-mounted operator interface
terminal for programmable logic controllers. It reads data from and writes
data to a programmable logic controller via an RS-232 port. There are
three models of SCADAPack Vision, SCADAPack Vision-10 (see Figure
1: SCADAPack Vision-10), SCADAPack Vision-50 (see Figure 2:
SCADAPack Vision-50) and SCADAPack Vision-60 (see Figure 3:
SCADAPack Vision - 60)
The SCADAPack Vision configuration software is used to configure the
SCADAPack Vision operator interface to display data read from the PLC
and to allow operator-entered data to be written to the PLC.
SCADAPack Vision-10 has 32-characters, two lines x 16 characters, LCD
that displays the data on a series of screens. Seven function buttons are
available to navigate through these screens, enter data or control power
to the unit.
SCADAPack Vision-50 has 80-characters, four lines x 20 characters, LCD
that displays the data on a series of screens. Twenty-one function buttons
are available to navigate through these screens, enter data or control
power to the unit.
SCADAPack Vision-60 has 80-characters, four lines x 20 characters, LCD
that displays the data on a series of screens. Twenty-one function buttons
are available to navigate through these screens, enter data or control
power to the unit. The SCADAPack Vision - 60 is identical to the
SCADAPack Vision – 50 with the exception that the SCADAPack Vision –
60 has 128K of application memory.
Data-display screens and button functionality are user-defined in
applications created with the companion SCADAPack Vision
configuration software. These applications are downloaded to the
SCADAPack Vision via a second RS-232 port.
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Figure 1: SCADAPack Vision-10

Figure 2: SCADAPack Vision-50
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Figure 3: SCADAPack Vision - 60

Organization of the Manual
This manual describes the SCADAPack Vision-10, SCADAPack Vision50 and SCADAPack Vision-60 operator interface (OI) terminals and
companion configuration software. It is organized into the following
sections.
Chapter SCADAPack Vision-10 describes installation of the hardware
and the hardware features of the SCADAPack Vision-10 Operator
Interface.
Chapter SCADAPack Vision-50 describes installation of the hardware
and the hardware features of the SCADAPack Vision-50 Operator
Interface.
Chapter SCADAPack Vision-60 describes installation of the hardware
and the hardware features of the SCADAPack Vision-60 Operator
Interface.
describes each of the SCADAPack Vision configuration commands
available from the SCADAPack Vision menu bar.

Additional Documentation
Additional documentation on the SCADAPack and TeleSAFE controllers
is found in the following documents.
The SCADAPack System Manual is a complete reference to the
Controller and I/O modules used with SCADAPack controllers. It contains
SCADAPack Vision User Manual 11/10/2011
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the SCADAPack Controller Hardware Manual – a complete reference
to the SCADAPack hardware – and hardware manuals for all 5000 Series
I/O modules.

System Requirements
Vision 2.07B is supported on the following operating systems.
•

Microsoft Windows 2000 Professional

•

Microsoft Windows XP Professional

•

Microsoft Windows 7 Professional on32-bit and 64-bit platforms

•

Windows Vista Ultimate on 32-bit and 64-bit platforms

•

Microsoft Windows Vista Enterprise on 32-bit and 64-bit platforms
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SCADAPack Vision-10

This section of the manual describes installation of the hardware and the
hardware features of the SCADAPack Vision-10 Operator Interface as
well as pin-outs for cables used to connect SCADAPack Vision-10 and
PLC or computer.

SCADAPack Vision-10 Installation
Hardware installation of the SCADAPack Vision-10 requires cutting an
opening into a panel cover or other suitable flat surface, and securing the
SCADAPack Vision-10 to the cover with provided hardware.
Each mounting hardware kit contains one cardboard cutout template, one
foam rubber gasket, two mounting screws, two plastic clamps and four
hex nuts.
To mount the SCADAPack Vision-10 in the panel cover:
Cut a 92.00mm x 45.00mm (1/8 DIN size) rectangular opening into the
panel cover.
Insert the SCADAPack Vision-10 into the foam rubber gasket.
Insert the SCADAPack Vision-10/gasket assembly into the rectangular
opening in the panel.
Insert a mounting screw into the small circular hole in the clamp.
Thread two hex nuts (touching together) onto the end of the mounting
screw and pull the mounting screw head away from the clamp to seat the
hex nuts into the hexagonal opening.
Attach the clamp/screw assembly to the SCADAPack Vision-10 by
inserting the two clamp hooks into the mounting holes on one side of the
SCADAPack Vision-10 and pulling the clamp away from the panel to lock
the clamp in place.
Push the screw towards the front of the SCADAPack Vision-10 until it
makes contact with the inside of the panel.
Tighten screw to compress the gasket and secure the SCADAPack
Vision-10 to the panel. Do not over-tighten.
Repeat clamp/screw assembly and mounting procedure for opposite side
of SCADAPack Vision-10.
See Figure 4: SCADAPack Vision-10 Panel Installation.
SCADAPack Vision User Manual 11/10/2011
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Figure 4: SCADAPack Vision-10 Panel Installation
The SCADAPack Vision-10 operator interface is made up of a front datadisplay panel and a back communication panel.

SCADAPack Vision-10 Reference
Front Panel
The front panel consists of an LCD screen, two output LEDs, one power
key and six application keys. See Figure 5: SCADAPack Vision-10
Front Panel Layout.
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Figure 5: SCADAPack Vision-10 Front Panel Layout
LCD Screen
The LCD (Liquid Crystal Display) screen displays two lines of 16
characters for a maximum of 32 characters.
Data to be read from the PLC is displayed on this screen and is
configured using the SCADAPack Vision configuration software.
Data to be entered by the operator and written to the PLC is also
displayed on this screen and is configured using the SCADAPack Vision
configuration software.
Output LEDs
Two LEDs are used to display the status of single-bit addresses read
from the PLC. The top LED is green and the bottom LED is red.
Writing an input or holding register-based tag to the LEDs using the Copy
tag to LED task controls the LEDs. See section Key Task Definitions for
more information.
The top LED is controlled by the state of bit 0 in the tag and the value of
the bottom LED is controlled by the state of the second bit in the tag.
Power Management Key
The Power Management key is used in conjunction with the power-saving
mode and COM3 of the SCADAPack LP controller to control power to the
SCADAPack Vision-10. Turning the SCADAPack Vision-10 off reduces
power consumption by approximately 100 mA. In low-power applications
where power use is critical, this feature is very important.
SCADAPack Vision User Manual 11/10/2011
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SCADAPack Vision-10 power is turned on for five minutes when a
momentary contact is made between pin 2 (DCD) and pin 3 (DTR) on the
COM3 RJ-45 connector. The Power Management key makes this contact
by momentarily shorting SCADAPack Vision-10 PLC port pin 1 to pin 4
when pressed. This permits the SCADAPack Vision or an HMI
pushbutton to control HMI power. At each momentary contact, the fiveminute power timer is reloaded. If the five-minute power timer is currently
maintaining the SCADAPack Vision-10 power on, depressing the Power
Management key for a two-second or longer period will turn off HMI
power.
Connecting the SCADAPack Vision-10 to COM3 on the SCADAPack LP
requires a special cable. Refer to Figure 10: SCADAPack Vision-10
PLC Port to SCADAPack LP Serial Port Connection for more
information.
The SCADAPack LP must be in power-saving mode to utilize the Power
Management key functionality.
Application keys
The Application keys are used to perform user-configurable actions either
globally (for all screens), or locally (active screen only). The functionality
of these keys is configured using the SCADAPack Vision configuration
software. These functions include screen-navigation, data entry & data
display.
Initialization Procedure
Initializing the SCADAPack Vision-10 erases the downloaded application
and initializes the SCADAPack Vision-10 memory. To initialize the
SCADAPack Vision-10:
Remove power to the SCADAPack Vision-10,
Press and hold the F1 and F6 keys simultaneously,
Restore power to the SCADAPack Vision-10,
Release the keys when the message “Initializing Memory…” message
appears in the display. The initialization is complete when the “CMI
VISION-10” message is displayed.
Back Panel
The back panel consists of two RS-232 serial ports identified as PLC Port
and Serial Port. See Figure 6: SCADAPack Vision-10 Back Panel
Layout.
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Figure 6: SCADAPack Vision-10 Back Panel Layout
Both RS-232 ports are 9-pin male D-sub-miniature (DE-9P) connectors
configured as Data Terminal Equipment (DTE). A maximum cable length
of 50 ft (15.2m) is allowed. All RS-232 wiring must use shielded cable.
The shield should be connected to chassis ground at one point. The DE-9
connector shell is a good ground point.
PLC Port
The PLC Port is used to pass serial data between the SCADAPack
Vision-10 and the PLC and to provide 5VDC to the SCADAPack Vision10 from the PLC. See Figure 7: SCADAPack Vision-10 PLC Port
Connections for the pin connections.
2
RxD

1
On
6

3
TxD
7

5
Gnd

4
On
8

9
+ 5V
In

Figure 7: SCADAPack Vision-10 PLC Port Connections
In the following table a MARK is a voltage of +3 volts or greater; a SPACE
is a voltage of –3 volts or less.
Pin

Type

Pin 1 On
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Pin

Type

Description

Pin 2 RxD

Input

Pin 3 TxD

Output

The level is SPACE on standby and MARK
for received data.
The RxD LED is lit for a MARK level.
The level is SPACE on standby and MARK
for transmitted data.
The LED is lit for a MARK level.
This pin is used by the SCADAPack LP to
control power to the SCADAPack Vision-10.
This pin is connected to the system ground.
Not used.
Not used.
Not used.
This pin must be connected to the 5V-power
supply of the PLC.

Pin 4 On
Pin 5 Ground
Pin 6
Pin 7
Pin 8
Pin 9

N/A
N/A
N/A
Input

PLC Port Cables
To connect the SCADAPack Vision-10 PLC port to any PLC serial port,
refer to the PLC hardware manual for serial port pin-out information, then
use Figure 8: SCADAPack Vision-10 PLC Port to PLC Serial Port
Connection as a guide to construct the appropriate cable.

Figure 8: SCADAPack Vision-10 PLC Port to PLC Serial Port
Connection

SCADAPack Vision User Manual 11/10/2011

20

SCADAPack Vision-10
To connect the SCADAPack Vision-10 PLC port to a SCADAPack,
SCADAPack LIGHT, SCADAPack PLUS or Micro 16 controller serial port,
use Figure 9: SCADAPack Vision-10 PLC Port to SCADAPack Serial
Port Connection as a guide to construct the appropriate cable. A 6-foot
long cable is available from Control Microsystems as part number
297241.

Figure 9: SCADAPack Vision-10 PLC Port to SCADAPack Serial Port
Connection
To connect the SCADAPack Vision-10 PLC port to a SCADAPack LP
controller serial port, use Figure 10: SCADAPack Vision-10 PLC Port to
SCADAPack LP Serial Port Connection as a guide to construct the
appropriate cable. A 5-foot long cable is available from Control
Microsystems as part number 297237.
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Figure 10: SCADAPack Vision-10 PLC Port to SCADAPack LP Serial
Port Connection
To connect the SCADAPack Vision-10 PLC port to a SCADAPack 32 or
SCADAPack 32P controller serial port, use Figure 11: SCADAPack
Vision-10 to SCADAPack32 RJ-45 Serial Port Connector as a guide to
construct the appropriate cable. A 5-foot long cable is available from
Control Microsystems as part number 297237.

Figure 11: SCADAPack Vision-10 to SCADAPack32 RJ-45 Serial Port
Connector
SCADAPack Vision User Manual 11/10/2011
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The above diagram represents the connection between the Vision 10 DB9 connector to a SCADAPack32 RJ-45 connector on comm. ports 1, 2
and 4. To connect the Vision 10 to the SCADAPack 32’s DB-9 connector
on comm. 3, use Figure 9: SCADAPack Vision-10 PLC Port to
SCADAPack Serial Port Connection.
Serial Port
The Serial Port is used to upload/download SCADAPack Vision-10
configuration applications and download SCADAPack Vision-10 firmware
from the computer serial port to the SCADAPack Vision-10. See Figure
12: SCADAPack Vision-10 Serial Port Connection for the pin
connections.
1

2
RxD
6

3
TxD
7

4
8

5
Gnd
9

Figure 12: SCADAPack Vision-10 Serial Port Connection
In the following table a MARK is a voltage of +3 volts or greater; a SPACE
is a voltage of –3 volts or less.
Pin

Type

Description

Pin 1
Pin 2 RxD

N/A
Input

Pin 3 TxD

Output

Pin 4
Pin 5 Ground
Pin 6
Pin 7
Pin 8
Pin 9

N/A

Not used.
The level is SPACE on standby and MARK
for received data.
The RxD LED is lit for a MARK level.
The level is SPACE on standby and MARK
for transmitted data.
The LED is lit for a MARK level.
Not used.
This pin is connected to the system ground.
Not used.
Not used.
Not used.
Not used.

N/A
N/A
N/A
N/A
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Serial Port Cable
To connect the SCADAPack Vision-10 Serial port to a computer serial
port, use Figure 13: SCADAPack Vision-10 Serial Port to Computer
Serial Port Connection as a guide to construct the appropriate cable. A
5-foot long cable is available from Control Microsystems as part number
294055.

Figure 13: SCADAPack Vision-10 Serial Port to Computer Serial Port
Connection
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SCADAPack Vision-50

This section of the manual describes installation of the hardware and the
hardware features of the SCADAPack Vision-50 Operator Interface as
well as pin-outs for cables used to connect SCADAPack Vision-50 and
PLC or computer.

SCADAPack Vision-50 Installation
Hardware installation of the SCADAPack Vision-50 requires cutting an
opening into a panel cover or other suitable flat surface, and securing the
SCADAPack Vision-50 to the cover with provided hardware.
Each mounting hardware kit contains one cardboard cutout template, one
foam rubber gasket, two mounting screws, two plastic clamps and four
hex nuts.
To mount the SCADAPack Vision-50 in the panel cover:
Cut a 162.00mm x 76.00mm (1/8 DIN size) rectangular opening into the
panel cover.
Insert the SCADAPack Vision-50 into the foam rubber gasket.
Insert the SCADAPack Vision-50/gasket assembly into the rectangular
opening in the panel.
Insert a mounting screw into the small circular hole in the clamp.
Thread two hex nuts (touching together) onto the end of the mounting
screw and pull the mounting screw head away from the clamp to seat the
hex nuts into the hexagonal opening.
Attach the clamp/screw assembly to the SCADAPack Vision-50 by
inserting the two clamp hooks into the mounting holes on one side of the
SCADAPack Vision-50 and pulling the clamp away from the panel to lock
the clamp in place.
Push the screw towards the front of the SCADAPack Vision-50 until it
makes contact with the inside of the panel.
Tighten screw to compress the gasket and secure the SCADAPack
Vision-50 to the panel. Do not over-tighten.
Repeat clamp/screw assembly and mounting procedure for opposite side
of SCADAPack Vision-50.
See Figure 14: SCADAPack Vision-50 Panel Installation.
SCADAPack Vision User Manual 11/10/2011
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Figure 14: SCADAPack Vision-50 Panel Installation
The SCADAPack Vision-50 operator interface is made up of a front datadisplay panel and a back communication
panel.
Completed

SCADAPack Vision-50 Reference
Front Panel
The front panel consists of an LCD screen, two output LEDs, one power
key and six application keys. See Figure 15: SCADAPack Vision-50
Front Panel Layout.

Figure 15: SCADAPack Vision-50 Front Panel Layout
SCADAPack Vision User Manual 11/10/2011
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LCD Screen
The LCD (Liquid Crystal Display) screen displays four lines of 20
characters for a maximum of 80 characters.
Data to be read from the PLC is displayed on this screen and is
configured using the SCADAPack Vision configuration software.
Data to be entered by the operator and written to the PLC is also
displayed on this screen and is configured using the SCADAPack Vision
configuration software.
Output LEDs
Eight LEDs are used to display the status of single-bit addresses read
from the PLC. All LEDs are red.
Writing an input or holding register-based tag to the LEDs using the Copy
tag to LED task controls the LEDs. See Key Task Definitions for more
information.
The first LED is controlled by the state of bit 0 second by the bit 1 and so
forth to LED 8, which is controlled, by the state of the bit 7 in the tag.
Power Management Key
The Power Management key is used in conjunction with the power-saving
mode and COM3 of the SCADAPack LP controller to control power to the
SCADAPack Vision-50. Turning the SCADAPack Vision-50 off reduces
power consumption by approximately 160 mA. In low-power applications
where power use is critical, this feature is very important.
SCADAPack Vision-50 power is turned on for five minutes when a
momentary contact is made between pin 2 (DCD) and pin 3 (DTR) on the
COM3 RJ-45 connector. The Power Management key makes this contact
by momentarily shorting SCADAPack Vision-50 PLC port pin 1 to pin 4
when pressed. This permits the SCADAPack Vision or an HMI
pushbutton to control HMI power. At each momentary contact, the fiveminute power timer is reloaded. If the five-minute power timer is currently
maintaining the SCADAPack Vision-50 power on, depressing the Power
Management key for a two-second or longer period will turn off HMI
power.
Connecting the SCADAPack Vision-50 to COM3 on the SCADAPack LP
requires a special cable. Refer to Figure 20: SCADAPack Vision-50
PLC Port to SCADAPack LP Serial Port Connection for more
information.
The SCADAPack LP must be in power-saving mode to utilize the Power
Management key functionality.
SCADAPack Vision User Manual 11/10/2011
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Application keys
The Application keys are used to perform user-configurable actions either
globally (for all screens), or locally (active screen only). The functionality
of these keys is configured using the SCADAPack Vision configuration
software. These functions include screen-navigation, data entry & data
display.
Initialization Procedure
Initializing the SCADAPack Vision-50 erases the previously downloaded
application and initializes the SCADAPack Vision-50 memory. To initialize
the SCADAPack Vision-50:
•

Remove power to the SCADAPack Vision-50,

•

Press and hold the F5[HOME] and ENT keys simultaneously,

•

Restore power to the SCADAPack Vision-50,

•

Release the keys when the message “Initializing Memory…” message
appears in the display. The initialization is complete when the
“VISION-50” message is displayed.

Back Panel
The back panel consists of two RS-232 serial ports identified as PLC Port
and Serial Port. See Figure 16: SCADAPack Vision-50 Back Panel
Layout.

Figure 16: SCADAPack Vision-50 Back Panel Layout
Both RS-232 ports are 9-pin male D-sub-miniature (DE-9P) connectors
configured as Data Terminal Equipment (DTE). A maximum cable length
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of 50ft (15.2m) is allowed. All RS-232 wiring must use shielded cable. The
shield should be connected to chassis ground at one point. The DE-9
connector shell is a good ground point.
PLC Port
The PLC Port is used to pass serial data between the SCADAPack
Vision-50 and the PLC and to provide 5VDC to the SCADAPack Vision50 from the PLC. See Figure 17: SCADAPack Vision-50 PLC Port
Connections for the pin connections.
2
RxD

1
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Figure 17: SCADAPack Vision-50 PLC Port Connections
In the following table a MARK is a voltage of +3 volts or greater; a SPACE
is a voltage of –3 volts or less.
Pin

Type

Pin 1 On
Pin 2 RxD

Input

Pin 3 TxD

Output

Pin 4 On
Pin 5 Ground
Pin 6
Pin 7
Pin 8
Pin 9

N/A
N/A
N/A
Input

Description
This pin is used by the SCADAPack LP to
control power to the SCADAPack Vision-50.
The level is SPACE on standby and MARK
for received data.
The RxD LED is lit for a MARK level.
The level is SPACE on standby and MARK
for transmitted data.
The LED is lit for a MARK level.
This pin is used by the SCADAPack LP to
control power to the SCADAPack Vision-50.
This pin is connected to the system ground.
Not used.
Not used.
Not used.
This pin must be connected to the 5V-power
supply of the PLC.

PLC Port Cables
To connect the SCADAPack Vision-50 PLC port to any PLC serial port,
refer to the PLC hardware manual for serial port pin-out information, and
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then use Figure 18: SCADAPack Vision-50 PLC Port to PLC Serial
Port Connection as a guide to construct the appropriate cable.

Figure 18: SCADAPack Vision-50 PLC Port to PLC Serial Port
Connection
To connect the SCADAPack Vision-50 PLC port to a SCADAPack,
SCADAPack LIGHT, SCADAPack PLUS or Micro 16 controller serial port,
use Figure 19: SCADAPack Vision-50 PLC Port to SCADAPack Serial
Port Connection as a guide to construct the appropriate cable. A 6-foot
long cable is available from Control Microsystems as part number
297241.
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Figure 19: SCADAPack Vision-50 PLC Port to SCADAPack Serial
Port Connection
To connect the SCADAPack Vision-50 PLC port to a SCADAPack LP
controller serial port, use Figure 20: SCADAPack Vision-50 PLC Port to
SCADAPack LP Serial Port Connection as a guide to construct the
appropriate cable. A 5-foot long cable is available from Control
Microsystems as part number 297237.
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Figure 20: SCADAPack Vision-50 PLC Port to SCADAPack LP Serial
Port Connection
To connect the SCADAPack Vision-50 PLC port to a SCADAPack 32 or
SCADAPack 32P controller serial port, use Figure 21: SCADAPack
Vision-50 to SCADAPack32 Serial Port Connection as a guide to
construct the appropriate cable. A 5-foot long cable is available from
Control Microsystems as part number 297237.

Figure 21: SCADAPack Vision-50 to SCADAPack32 Serial Port
Connection
The above diagram represents the connection between the Vision 50 DB9 connector to a SCADAPack32 RJ-45 connector on comm. ports 1, 2
and 4. To connect the Vision 50 to the SCADAPack 32’s DB-9 connector
on comm. 3, use Figure 9: SCADAPack Vision-10 PLC Port to
SCADAPack Serial Port Connection.
Serial Port
The Serial Port is used to upload/download SCADAPack Vision-50
configuration applications and download SCADAPack Vision-50 firmware
from the computer serial port to the SCADAPack Vision-50. See Figure
22 SCADAPack Vision-50 Serial Port Connection for the pin
connections.
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Figure 22 SCADAPack Vision-50 Serial Port Connection
In the following table a MARK is a voltage of +3 volts or greater; a SPACE
is a voltage of –3 volts or less.
Pin

Type

Description

Pin 1
Pin 2 RxD

N/A
Input

Pin 3 TxD

Output

Pin 4
Pin 5 Ground
Pin 6
Pin 7
Pin 8
Pin 9

N/A

Not used.
The level is SPACE on standby and MARK
for received data.
The RxD LED is lit for a MARK level.
The level is SPACE on standby and MARK
for transmitted data.
The LED is lit for a MARK level.
Not used.
This pin is connected to the system ground.
Not used.
Not used.
Not used.
Not used.

N/A
N/A
N/A
N/A

Serial Port Cable
To connect the SCADAPack Vision-50 Serial port to a computer serial
port, use Figure 23: SCADAPack Vision-50 Serial Port to Computer
Serial Port Connection as a guide to construct the appropriate cable. A
5-foot long cable is available from Control Microsystems as part number
294055.
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Figure 23: SCADAPack Vision-50 Serial Port to Computer Serial Port
Connection
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This section of the manual describes installation of the hardware and the
hardware features of the SCADAPack Vision-60 Operator Interface as
well as pin-outs for cables used to connect SCADAPack Vision-60 and
PLC or computer.

SCADAPack Vision-60 Installation
Hardware installation of the SCADAPack Vision-60 requires cutting an
opening into a panel cover or other suitable flat surface, and securing the
SCADAPack Vision-60 to the cover with provided hardware.
Each mounting hardware kit contains one cardboard cutout template, one
foam rubber gasket, two mounting screws, two plastic clamps and four
hex nuts.
To mount the SCADAPack Vision-60 in the panel cover:
Cut a 162.00mm x 76.00mm (1/8 DIN size) rectangular opening into the
panel cover.
Insert the SCADAPack Vision-60 into the foam rubber gasket.
Insert the SCADAPack Vision-60/gasket assembly into the rectangular
opening in the panel.
Insert a mounting screw into the small circular hole in the clamp.
Thread two hex nuts (touching together) onto the end of the mounting
screw and pull the mounting screw head away from the clamp to seat the
hex nuts into the hexagonal opening.
Attach the clamp/screw assembly to the SCADAPack Vision-60 by
inserting the two clamp hooks into the mounting holes on one side of the
SCADAPack Vision-60 and pulling the clamp away from the panel to lock
the clamp in place.
Push the screw towards the front of the SCADAPack Vision-60 until it
makes contact with the inside of the panel.
Tighten screw to compress the gasket and secure the SCADAPack
Vision-60 to the panel. Do not over-tighten.
Repeat clamp/screw assembly and mounting procedure for opposite side
of SCADAPack Vision-60.
See Figure 24: SCADAPack Vision-60 Panel Installation.
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Figure 24: SCADAPack Vision-60 Panel Installation
The SCADAPack Vision-60 operator interface is made up of a front datadisplay panel and a back communication panel.

SCADAPack Vision-60 Reference
Front Panel
The front panel consists of an LCD screen, two output LEDs, one power
key and six application keys. See Figure 25: SCADAPack Vision-60
Front Panel Layout.
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Figure 25: SCADAPack Vision-60 Front Panel Layout
LCD Screen
The LCD (Liquid Crystal Display) screen displays four lines of 20
characters for a maximum of 80 characters.
Data to be read from the PLC is displayed on this screen and is
configured using the SCADAPack Vision configuration software.
Data to be entered by the operator and written to the PLC is also
displayed on this screen and is configured using the SCADAPack Vision
configuration software.
Output LEDs
Eight LEDs are used to display the status of single-bit addresses read
from the PLC. All LEDs are red.
Writing an input or holding register-based tag to the LEDs using the Copy
tag to LED task controls the LEDs. See Key Task Definitions for more
information.
The first LED is controlled by the state of bit 0 second by the bit 1 and so
forth to LED 8, which is controlled, by the state of the bit 7 in the tag.
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Power Management Key
The Power Management key is used in conjunction with the power-saving
mode and COM3 of the SCADAPack LP controller to control power to the
SCADAPack Vision-60. Turning the SCADAPack Vision-60 off reduces
power consumption by approximately 160 mA. In low-power applications
where power use is critical, this feature is very important.
SCADAPack Vision-60 power is turned on for five minutes when a
momentary contact is made between pin 2 (DCD) and pin 3 (DTR) on the
COM3 RJ-45 connector. The Power Management key makes this contact
by momentarily shorting SCADAPack Vision-60 PLC port pin 1 to pin 4
when pressed. This permits the SCADAPack Vision or an HMI
pushbutton to control HMI power. At each momentary contact, the fiveminute power timer is reloaded. If the five-minute power timer is currently
maintaining the SCADAPack Vision-60 power on, depressing the Power
Management key for a two-second or longer period will turn off HMI
power.
Connecting the SCADAPack Vision-60 to COM3 on the SCADAPack LP
requires a special cable. Refer to Figure 30: SCADAPack Vision-60
PLC Port to SCADAPack LP Serial Port Connection for more
information.
The SCADAPack LP must be in power-saving mode to utilize the Power
Management key functionality.
Application keys
The Application keys are used to perform user-configurable actions either
globally (for all screens), or locally (active screen only). The functionality
of these keys is configured using the SCADAPack Vision configuration
software. These functions include screen-navigation, data entry & data
display.
Initialization Procedure
Initializing the SCADAPack Vision-60 erases the previously downloaded
application and initializes the SCADAPack Vision-60 memory. To initialize
the SCADAPack Vision-60:
•

Press and hold the F2 key

•

Cycle power to the SCADAPack Vision-60.

•

Then press the ENT key while still holding the F2 key.

•

Release the keys when the message “Initializing Memory…” message
appears in the display. The initialization is complete when the
“VISION-60” message is displayed.
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Back Panel
The back panel consists of two RS-232 serial ports identified as PLC Port
and Serial Port. See Figure 26: SCADAPack Vision-60 Back Panel
Layout.

Figure 26: SCADAPack Vision-60 Back Panel Layout
Both RS-232 ports are 9-pin male D-sub-miniature (DE-9P) connectors
configured as Data Terminal Equipment (DTE). A maximum cable length
of 50ft (15.2m) is allowed. All RS-232 wiring must use shielded cable. The
shield should be connected to chassis ground at one point. The DE-9
connector shell is a good ground point.
PLC Port
The PLC Port is used to pass serial data between the SCADAPack
Vision-60 and the PLC and to provide 5VDC to the SCADAPack Vision60 from the PLC. See Figure 27: SCADAPack Vision-60 PLC Port
Connections for the pin connections.
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Figure 27: SCADAPack Vision-60 PLC Port Connections
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In the following table a MARK is a voltage of +3 volts or greater; a SPACE
is a voltage of –3 volts or less.
Pin

Type

Pin 1 On
Pin 2 RxD

Input

Pin 3 TxD

Output

Pin 4 On
Pin 5 Ground
Pin 6
Pin 7
Pin 8
Pin 9

N/A
N/A
N/A
Input

Description
This pin is used by the SCADAPack LP to
control power to the SCADAPack Vision-60.
The level is SPACE on standby and MARK
for received data.
The RxD LED is lit for a MARK level.
The level is SPACE on standby and MARK
for transmitted data.
The LED is lit for a MARK level.
This pin is used by the SCADAPack LP to
control power to the SCADAPack Vision-60.
This pin is connected to the system ground.
Not used.
Not used.
Not used.
This pin must be connected to the 5V-power
supply of the PLC.

PLC Port Cables
To connect the SCADAPack Vision-60 PLC port to any PLC serial port,
refer to the PLC hardware manual for serial port pin-out information, and
then use Figure 28: SCADAPack Vision-60 PLC Port to PLC Serial
Port Connection as a guide to construct the appropriate cable.
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Figure 28: SCADAPack Vision-60 PLC Port to PLC Serial Port
Connection
To connect the SCADAPack Vision-60 PLC port to a SCADAPack,
SCADAPack LIGHT, SCADAPack PLUS or Micro 16 controller serial port,
use Figure 29: SCADAPack Vision-60 PLC Port to SCADAPack Serial
Port Connection as a guide to construct the appropriate cable. A 6-foot
long cable is available from Control Microsystems as part number
297241.

Figure 29: SCADAPack Vision-60 PLC Port to SCADAPack Serial
Port Connection
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To connect the SCADAPack Vision-60 PLC port to a SCADAPack LP
controller serial port, use Figure 30: SCADAPack Vision-60 PLC Port to
SCADAPack LP Serial Port Connection as a guide to construct the
appropriate cable. A 5-foot long cable is available from Control
Microsystems as part number 297237.

Figure 30: SCADAPack Vision-60 PLC Port to SCADAPack LP Serial
Port Connection
To connect the SCADAPack Vision-60 PLC port to a SCADAPack 32 or
SCADAPack 32P controller serial port, use Figure 31: SCADAPack
Vision-60 to SCADAPack32 Serial Port Connection as a guide to
construct the appropriate cable. A 5-foot long cable is available from
Control Microsystems as part number 297237.
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Figure 31: SCADAPack Vision-60 to SCADAPack32 Serial Port
Connection
The above diagram represents the connection between the Vision-60 DB9 connector to a SCADAPack32 RJ-45 connector on comm. ports 1, 2
and 4. To connect the Vision 60 to the SCADAPack 32’s DB-9 connector
on comm. 3, use Figure 9: SCADAPack Vision-10 PLC Port to
SCADAPack Serial Port Connection.
Serial Port
The Serial Port is used to upload/download SCADAPack Vision-60
configuration applications and download SCADAPack Vision-60 firmware
from the computer serial port to the SCADAPack Vision-60. See Figure
32: SCADAPack Vision-60 Serial Port Connection for the pin
connections.
1
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RxD
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3
TxD
7

4
8

5
Gnd
9

Figure 32: SCADAPack Vision-60 Serial Port Connection
In the following table a MARK is a voltage of +3 volts or greater; a SPACE
is a voltage of –3 volts or less.
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Pin

Type

Description

Pin 1
Pin 2 RxD

N/A
Input

Pin 3 TxD

Output

Pin 4
Pin 5 Ground
Pin 6
Pin 7
Pin 8
Pin 9

N/A

Not used.
The level is SPACE on standby and MARK
for received data.
The RxD LED is lit for a MARK level.
The level is SPACE on standby and MARK
for transmitted data.
The LED is lit for a MARK level.
Not used.
This pin is connected to the system ground.
Not used.
Not used.
Not used.
Not used.

N/A
N/A
N/A
N/A

Serial Port Cable
To connect the SCADAPack Vision-60 Serial port to a computer serial
port, use Figure 33: SCADAPack Vision-60 Serial Port to Computer
Serial Port Connection as a guide to construct the appropriate cable. A
5-foot long cable is available from Control Microsystems as part number
294055.

Figure 33: SCADAPack Vision-60 Serial Port to Computer Serial Port
Connection

SCADAPack Vision User Manual 11/10/2011

44

SCADAPack Vision Configuration Software

SCADAPack Vision Configuration Software

The SCADAPack Vision software is used to configure the SCADAPack
Vision operator interface to display data read from the PLC and to allow
operator-entered data to be written to the PLC.
This manual provides full documentation of the SCADAPack Vision
configuration software. We strongly encourage you to read it, and to notify
us if you find any errors or omissions that you feel should be included in
our documentation.
Although communication with many different types of PLC is supported by
the SCADAPack Vision, only the SCADAPack family of PLC will be dealt
with in this manual.
To use the SCADAPack Vision configuration software, you need to install
it on your system. The automated installation takes only a few minutes.
Some virus checking software may interfere with the installation. If you
experience problems with the installation, disable the virus checker and
try the installation again.
System Requirements
The minimum system configuration for the SCADAPack Vision software
is:
•

Microsoft Windows 9X/2000/ME/NT operating system.

•

Mouse or compatible pointing device.

•

Hard disk with approximately 2.0 MB of free disk space.

Installation on a Hard Disk
To install the SCADAPack Vision Configuration software:
Insert the SCADAPack Vision setup CD into the CD ROM drive.
From the Windows Program Manager File menu choose Run.
From the Run dialog box select Browse and select the setup.exe file in
the Vision folder on the CD.
Follow the setup directions on the screen.
Running SCADAPack Vision Software
To run the SCADAPack Vision software:
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In the Vision group of the Program Manager, double click on the Vision
icon.
If you running SCADAPack Vision Configuration software first time or you
opening new application, following screen will be displayed.

To select type of the display to be configured, click on one of
SCADAPack Vision-10, SCADAPack Vision-50 SCADAPack Vision-60 or
icons in the screen displayed above.

SCADAPack Vision Configuration Software Environment
This section of the manual outlines the features of the SCADAPack Vision
configuration software. A full description of the software is given in the
SCADAPack Vision Configuration Software Reference section of the
manual.
The user is encouraged to read the following sections to gain an
understanding of the many programming features available.
SCADAPack Vision Configuration Software Display
The SCADAPack Vision Configuration software is shown below.
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Title Bar

Tools
Menu

Status Bar

Title Bar
The title bar displays the SCADAPack Vision title and the name of the
currently open SCADAPack Vision configuration file. The file name area
is blank if there is no file in use or if the file is new and has not yet been
saved.
Menu Bar
The menu bar displays the programming, editing and utility functions
available within the configuration software. Menu commands can be
displayed by clicking the mouse cursor on the menu item or by pressing
the “alt” concurrently with the underlined letter of the menu item. Pressing
a particular keyboard function key may also activate certain menu
commands. The alternate function keys are listed beside the menu
command.
Tool Bar
The tool bar contains buttons for commonly used commands.
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Help:
Opens the online help file. This is the same as the
Index [F1] command in the Help menu.

New File: Resets the SCADAPack Vision configuration
software and opens a new file. This is the same as the New command in
the File menu.

Open File: Opens an existing SCADAPack Vision
configuration file. This is the same as the Open command in the File
menu.

Upload Application:
Reads (uploads) the SCADAPack
Vision application file from the SCADAPack Vision operator interface into
the computer. This is the same as the Upload command in the
Communicate menu.

Download Application:
Writes (downloads) the SCADAPack
Vision application file to the SCADAPack Vision operator interface. This is
the same as the Download command in the Communicate menu.

Save File: Saves the currently open configuration file. This is
the same as the Save [F2] command in the File menu.

Exit Application:
Exits the SCADAPack Vision configuration
software. This is the same as the Exit [Alt+F4] command in the File menu.

Vision Settings: Defines the SCADAPack Vision memory,
keypad, and floating point variable format settings. This is the same as
the Settings [F3] command in the Define menu.
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Network Configuration: Defines the Modbus station address
for the SCADAPack Vision and the PLC. This is the same as the Network
Configuration [F4] command in the Define menu.

Tags:
Defines tags in the tag database. This is the same
as the Tag Database [F5] command in the Define menu.

Screens: Defines the data display screens. This is the same
as the Screens [F6] command in the Define menu.

Global Keys:
Defines global key functionality. This is the
same as the Global Key [F7] command from the Define menu.

Alarms:
Defines alarms. This is the same as the Alarms [F8]
command in the Define Menu.

Application Task Lists:
Defines application tasks. This is the
same as the Application Tasklists [F9] command in the Define menu.
Status Bar
The status bar displays the computer-based time and a brief description
of a toolbar command if the mouse cursor is pointed at the command
button.
Task Sequence Algorithm
The SCADAPack Vision follows a particular sequence for performing the
tasks as defined by the user. Please refer to Figure 34: Task Sequence
Algorithm for more information.
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Figure 34: Task Sequence Algorithm
SCADAPack Vision-10 Initialization
Initializing the SCADAPack Vision-10 erases the downloaded application
and initializes the SCADAPack Vision-10 memory. To initialize the
SCADAPack Vision-10:
•

Remove power to the SCADAPack Vision-10,

•

Press and hold the F1 and F6 keys simultaneously,
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•

Restore power to the SCADAPack Vision-10,

•

Release the keys when the message “Initializing Memory…” message
appears in the display. The initialization is complete when the “CMI
VISION-10” message is displayed.

If application download is interrupted, the boot-loader could be corrupted.
Boot-loader can be recovered by following this procedure:
•

Remove power to the SCADAPack Vision.

•

Press and hold the F1, F3 and F5 keys simultaneously and firmly.

•

Restore power to the SCADAPack Vision.

•

Keeping the keys pressed for at least three seconds, wait until a blank
screen appears (yellow backlight without characters). This screen
may contain spurious data on the upper LCD line.

•

Release all the three keys.

•

Press F2 within 15 seconds.

•

After approximately 10 seconds remove power to the SCADAPack
Vision.

•

Restore power to the SCADAPack Vision. It should now contain only
the boot-loader. The unit should now accept the firmware download.

SCADAPack Vision-50 Initialization
Initializing the SCADAPack Vision-50 erases the previously downloaded
application and initializes the SCADAPack Vision-50 memory. To initialize
the SCADAPack Vision-50:
•

Remove power to the SCADAPack Vision-50,

•

Press and hold the F5[HOME] and ENT keys simultaneously,

•

Restore power to the SCADAPack Vision-50,

•

Release the keys when the message “Initializing Memory…” message
appears in the display. The initialization is complete when the
“VISION-50” message is displayed.

If application download is interrupted, the boot-loader could be corrupted.
Boot-loader can be recovered by following this procedure:
•

Remove power to the SCADAPack Vision-50.

•

Press and hold the F5[HOME], F6 [ACK] and F7[Up-arrow] keys
simultaneously and firmly.

•

Restore power to the SCADAPack Vision-50.
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•

Keeping the keys pressed for at least three seconds, wait until a blank
screen appears (yellow backlight without characters). This screen
may contain spurious data on the upper LCD line.

•

Release all the three keys.

•

Press F1[NEXT] within 15 seconds.

•

After approximately 10 seconds remove power to the SCADAPack
Vision-50.

•

Restore power to the SCADAPack Vision-50. It should now contain
only the boot-loader. The unit should now accept the firmware
download.

SCADAPack Vision-60 Initialization
Initializing the SCADAPack Vision-60 erases the previously downloaded
application and initializes the SCADAPack Vision-50 memory. To initialize
the SCADAPack Vision-60:
•

Press and hold the F2 key

•

Cycle power to the SCADAPack Vision-60.

•

Then press the ENT key while still holding the F2 key.

•

Release the keys when the message “Initializing Memory…” message
appears in the display. The initialization is complete when the
“VISION-60” message is displayed.

If application download is interrupted, the boot-loader could be corrupted.
Boot-loader can be recovered by following this procedure:
•

Remove power to the SCADAPack Vision-60.

•

Press and hold the F5[HOME], F6 [ACK] and F7[Up-arrow] keys
simultaneously and firmly.

•

Restore power to the SCADAPack Vision-60.

•

Keeping the keys pressed for at least three seconds, wait until a blank
screen appears (yellow backlight without characters). This screen
may contain spurious data on the upper LCD line.

•

Release all the three keys.

•

Press F1[NEXT] within 15 seconds.

•

After approximately 10 seconds remove power to the SCADAPack
Vision-60.
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•

Restore power to the SCADAPack Vision-60. It should now contain
only the boot-loader. The unit should now accept the firmware
download.

Application and Firmware Download
The Download command opens the Downloading from Computer to
SCADAPack Vision dialog.

This dialog is used to write the currently open application file or firmware
to the SCADAPack Vision.
The Communication Port command opens the Communication Port
dialog. This is the same as the Communication Port command in the
Communicate menu.
Selecting the Firmware radio button downloads the firmware file, located
in the \Vision\drivers\ subdirectory, to the SCADAPack Vision when the
Ok command is selected. The firmware file has the file extension “.abs”.
Downloading firmware overwrites existing firmware in the SCADAPack
Vision.
If communication is disrupted during the firmware download procedure,
the SCADAPack Vision display will appear blank. Waiting 30 seconds or
cycling power to the SCADAPack Vision is required before attempting to
download the firmware again. If the SCADAPack Vision still does not
respond to the firmware download, the boot-loader may have been
corrupted. However, it may still be recoverable by following this
procedure:
SCADAPack Vision-10 firmware erase procedure:
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Remove power to the SCADAPack Vision-10.
Press and hold the F1, F3 and F5 keys simultaneously and firmly.
Restore power to the SCADAPack Vision-10.
Keeping the keys pressed for at least three seconds, wait until a blank
screen appears (yellow backlight without characters). This screen may
contain spurious data on the upper LCD line.
Release all the three keys.
Press F2 within 15 seconds.
After approximately 10 seconds remove power to the SCADAPack Vision10.
Restore power to the SCADAPack Vision-10. It should now contain only
the boot-loader. The unit should now accept the firmware download.
SCADAPack Vision-50 firmware erase procedure:
Remove power to the SCADAPack Vision-50.
Press and hold the F5[HOME], F6 [ACK] and F7[Up-arrow] keys
simultaneously and firmly.
Restore power to the SCADAPack Vision-50.
Keeping the keys pressed for at least three seconds, wait until a blank
screen appears (yellow backlight without characters). This screen may
contain spurious data on the upper LCD line.
Release all the three keys.
Press F1[NEXT] within 15 seconds.
After approximately 10 seconds remove power to the SCADAPack Vision50.
Restore power to the SCADAPack Vision-50. It should now contain only
the boot-loader. The unit should now accept the firmware download.
SCADAPack Vision-60 firmware erase procedure:
Remove power to the SCADAPack Vision-60.
Press and hold the F5[HOME], F6 [ACK] and F7[Up-arrow] keys
simultaneously and firmly.
Restore power to the SCADAPack Vision-60.
Keeping the keys pressed for at least three seconds, wait until a blank
screen appears (yellow backlight without characters). This screen may
contain spurious data on the upper LCD line.
Release all the three keys.
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Press F1[NEXT] within 15 seconds.
After approximately 10 seconds remove power to the SCADAPack Vision60.
Restore power to the SCADAPack Vision-60. It should now contain only
the boot-loader. The unit should now accept the firmware download.
Selecting the Application radio button downloads the currently open
application file to the SCADAPack Vision when the Ok command is
selected. Downloading an application erases the application in the
SCADAPack Vision.
Download progress is indicated with a red line that moves from the
computer graphic to the SCADAPack Vision.
The Ok command downloads (writes) either the firmware or application
file from the computer to the SCADAPack Vision depending on the radio
button selection.
The Close command closes the dialog.
The Help command displays the on-line help for the dialog.

SCADAPack Vision-10 Program Development
This section of the manual is organized in a manner that will lead the new
user through the steps required to create a SCADAPack Vision-10
configuration file and download the file to the SCADAPack Vision-10
operator interface. It is recommended that new users follow the steps
outlined in this section.
Open SCADAPack Vision Software
Create New Configuration File
Configure Network Configuration
Configure Tags
Configure Screens
Configure Application Task List
Save the Configuration file
Download Configuration File to SCADAPack Vision-10
Connect SCADAPack Vision-10 to PLC
The SCADAPack Vision-10 operator interface displays PLC register data
and provides operators with the ability to write data to the PLC. A
SCADAPack Vision configuration file must be created and downloaded to
the SCADAPack Vision-10 operator interface in order to utilize the
SCADAPack Vision-10 operator interface.
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The SCADAPack Vision configuration that will be created in this example
procedure will contain four display screens, each containing data
elements for the four supported data types.
This section of the manual assumes that you have configured a
SCADAPack Series PLC (or similar) to be polled as a Modbus slave by
the SCADAPack Vision-10.
The SCADAPack Vision Configuration section contains detailed
explanations for all the commands and functions described in this section.
In addition to this section, the on-line help for the SCADAPack Vision
program contains a complete reference for the program. To display online help, select the Index command from the Help menu.
Follow the steps outlined below to configure the SCADAPack Vision-10
and download the file to the operator interface.
Open SCADAPack Vision Software
From the START | PROGRAMS | Vision menu, select the SCADAPack
Vision icon to open the configuration software and select SCADAPack
Vision-10 to be configured.
Create New Configuration File
From the File menu, select New. A graphic of the SCADAPack Vision is
displayed.
Select SCADAPack Vision-10 icon to choose the SCADAPack Vision-10
and close the dialog.
Configure Network Configuration
The Network Configuration dialog is used to identify the PLC with which
the SCADAPack Vision will communicate.
From the Define menu, select Network Configuration. The following dialog
appears:
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Select the Add a node button. The four data entry fields are filled as
follows:

The settings that are displayed configure the SCADAPack Vision-10 to
communicate with a SCADAPack Series controller, station address 1.
Select Ok to accept these settings and close the dialog.
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Select the Close button to accept the Network Configuration settings and
close the dialog.
Configure Tags
A “Tag” is an identifying name given to each data point that is to be read
from or written to the PLC.
The four types of SCADAPack PLC data registers supported by the
SCADAPack Vision-10 are:
Coils, (SCADAPack 0XXXX series)
Input status, (SCADAPack 1XXXX series)
Input registers, (SCADAPack 3XXXX series) and
Holding registers (SCADAPack 4XXXX series).
To configure tags:
From the Define menu, select the Tag Database command. The following
dialog appears:

In the Node data field, select the “[ 001 : Node1 ] Control Microsystems
(SCADAPack)” entry. This action allows for the configuration of tags
related to the IO database addresses found in the SCADAPack PLC.
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With “Coils” displayed in the Read-Write data field, and “00001” displayed
in the [00001 – 65536] field, enter “DOUT1” in the Tag-Name field.
Select the Add button. A tag named “DOUT1” is created which is
associated with the SCADAPack IO database address 00001. The tag is
displayed in the tag list at the top of the dialog.
Select “Input Status” in the Read-Write data field.
With “00001” displayed in the [00001 – 65536] field, enter “DIN1” in the
Tag-Name field.
Select the Add button. A tag named “DIN1” is created which is associated
with the SCADAPack IO database address 10001.
Select “Input Registers” in the Read-Write data field.
With “00001” displayed in the [00001 – 65536] field, the Register TagType radio button selected, and “2-Bytes (1-word)” displayed in the
Byte(s) field, enter “AIN1” in the Tag-Name field.
Select the Add button. A tag named “AIN1” is created which is associated
with the SCADAPack IO database address 30001.
Select “Holding Registers” in the Read-Write data field.
Select “4-Bytes (2-words)” in the Byte(s) field.
With “00001” displayed in the [00001 – 65536] field and the Register TagType radio button selected, enter “FP1” in the Tag-Name field.
Select the Add button. A tag named “FP1” is created which is associated
with the SCADAPack IO database addresses 40001 and 40002.
When completed, the Tags dialog should appear like this:
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Select the Close button to save the configured tags and close the dialog.
Configure Screens
PLC data associated with tags is displayed on the SCADAPack Vision10’s LCD by configuring “screens”. Up to 65354 screens, each displaying
up to thirty-two characters on two lines, can be configured. Scrolling
through these screens and entering data is accomplished by configuring
action-buttons related to a particular screen.
To configure screens:
From the Define menu, select the Screens command. The following
dialog is displayed:
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Select the Ok button to accept these settings for Screen 1. The following
display is displayed in the middle of the screen configuration display. This
display correlates to the actual LCD on the SCADAPack Vision-10.

From the Objects | Alphanumeric Objects menu, select the Text
command. The cursor changes to the Text cursor.
With the Text cursor, select the upper left corner of the top line of the
screen display. Then click and drag to the lower right corner of the top
line of the screen display. Release the mouse button.

At the flashing cursor box, enter the text “Digital Input #1”, (omit the
quotations). This text string should fit exactly into the top line of the
display.
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From the Objects | Alphanumeric Objects menu, select the Display PLC
Data command. The cursor changes to the Display Data cursor.
With the Display Data cursor, select the upper left corner of the bottom
line of the screen display. Then click and drag to the lower right corner of
the bottom line. Release the mouse button. The following dialog appears:

With the Bit Text radio button selected, choose “100001 (DIN1)” in the
Coil-Tag data entry field.
Enter “ON” in the Bit On Text field.
Enter “OFF” in the Bit Off Text field. When completed the dialog should
appear like this:

SCADAPack Vision User Manual 11/10/2011

64

SCADAPack Vision Configuration Software

Select the Ok button to accept the configuration and close the dialog. The
completed screen should appear like this:

To create a second screen, from the Screen menu, select the New
command.
Select Ok on the New Screen dialog to create Screen 2.
As with Screen 1, enter the text string “Digital Out #1” into the top line of
the display.
From the Objects | Alphanumeric Objects menu, select the Data Entry
command. The cursor changes to the Data Entry cursor.
With the Data Entry cursor, select the upper left corner of the bottom line
of the screen display. Then click and drag to the lower right corner of the
bottom line. Release the mouse button. The following dialog appears:
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With the Coil radio button selected and “000001 (DOUT1)” displayed in
the Coil-Tag data field, enter “TURN OFF?” into the On Text field.
Enter “TURN ON?” into the Off Text field. When completed, the dialog
should appear like this:

Select the Ok button to accept the configuration and close the dialog. The
completed screen should appear like this:

To create a third screen, from the Screen menu, select the New
command.
Select Ok on the New Screen dialog to create Screen 3.
As with the two previous screens, enter the text string “Analog Input #1”
into the top line of the display.
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From the Objects | Alphanumeric Objects menu, select the Display PLC
Data command. The cursor changes to the Display Data cursor.
With the Display Data cursor, select the upper left corner of the bottom
line of the screen display. Then click and drag to the lower right corner of
the bottom line. Release the mouse button. The following dialog appears:

Select the Register Value radio button. The dialog changes its
appearance to the following:

With “300001 (AIN1)” displayed in the Register-Tag field, “Unsigned
integer” in the Data Type field and “#####” in the Format field, select the
Ok button to accept this configuration and close the dialog.
When completed, the screen display should appear like this:
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To create the fourth and last screen, from the Screen menu, select the
New command.
Select Ok on the New Screen dialog to create Screen 4.
As with the previous screens, enter the text string “Floating Point#1” into
the top line of the display.
From the Objects | Alphanumeric Objects menu, select the Data Entry
command. The cursor changes to the Data Entry cursor.
With the Data Entry cursor, select the upper left corner of the bottom line
of the screen display. Then click and drag to the lower right corner of the
bottom line. Release the mouse button. The following dialog appears:

Select the Register radio button. The dialog changes its appearance to
the following:
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Select the “400001 (FP1)” entry in the Register-Tag field.
Select the “Float” entry in the Data Type field.
Select the “########.##” entry in the Format field. When completed, the
dialog should appear like this:

Select the Ok button to accept the configuration and close the dialog.
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When completed, the screen display should appear like this:

To navigate between these four screens, the NEXT and PREV keys are
used. These keys are configured by default to change to either the next
screen or the previous screen. However, in order to scroll through the four
screens in a “wrap-around” mode, the PREV key for Screen 1 has to be
reprogrammed to go to Screen 4 and the NEXT key on Screen 4 has to
be reprogrammed to go to screen 1. While remaining with Screen 4 on
the display, from the Screen menu, select the Keys for Screen command.
The following dialog appears:

Select the NEXT button.
Select the “Goto Screen” entry in the Select a Task to add field.
From the Goto Screen dialog list that appears, select “00001 Screen1”.
Select Ok to accept the configuration and close the dialog. When
completed, the dialog should appear like this:
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Select the Close button to accept the configuration and close the dialog.
From the Screen menu, select the Select Screen command.
From the Select Screen dialog list that appears, select “00001 Screen1”.
Select Ok to accept the configuration and close the dialog. Screen 1 is
now displayed in the dialog.
As with Screen 4, configure the PREV button on Screen 1 to go to Screen
4. When completed, the dialog should appear like this:
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Select the Close button to accept the configuration and close the dialog.
From the Screens menu, select the Close Screens session command to
accept the screens configuration and close the screen-editing dialog.
Configure Application Task List
In this example, Screen 1 will be automatically displayed each time power
is applied to the SCADAPack Vision-10. This is accomplished with the
Application Task List.
From the Define menu, select the Application Tasklists command. The
following dialog appears:
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With the Power-0n Tasks radio button selected, choose “Goto Screen” in
the Select a Task to add field.
From the Goto Screen dialog list that appears, select “00001 Screen1”.
Select Ok to accept the configuration and close the dialog. When
completed, the dialog should appear like this:
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Select the Close button to accept the configuration and close the dialog.
Save the Configuration file
The SCADAPack Vision-10 configuration, completed with steps 1 to 6,
can be saved to a configuration file for future use. The file has the “pzm”
file extension.
To save the configuration file
From the File menu, select the Save as command.
Change the entry in the File name field to “demo.pzm”.
Using the Save in field and the file folder list, locate a suitable hard drive
or server location to save the configuration file.
Select the Save button to save the configuration file and close the dialog.
Connect SCADAPack Vision-10 to PLC
In order for the SCADAPack Vision-10 operator interface to communicate
with the PLC, a special null modem cable has to be used. This cable must
provide 5VDC on pin 9 to power the SCADAPack Vision-10. The
SCADAPack series of controllers provides the required power on pin 9.
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To connect the SCADAPack Vision-10 to the PLC
Configure a four-wire null modem cable, (see Figure 9: SCADAPack
Vision-10 PLC Port to SCADAPack Serial Port Connection).
Connect the cable from the SCADAPack Vision-10 PLC Port to the PLC
serial port. As soon as the connection is made, the LCD display on the
SCADAPack Vision-10 should illuminate and the downloaded application
should function. If the SCADAPack Vision-10 does not power up, check
that 5VDC is present on pin 9 of the SCADAPack Vision-10 to PLC Port
cable.
Initialize SCADAPack Vision-10
Initializing the SCADAPack Vision-10 erases the previously downloaded
application and initializes the SCADAPack Vision-10 memory. To initialize
the SCADAPack Vision-10:
Remove power to the SCADAPack Vision-10,
Press and hold the F1 and F6 keys simultaneously,
Restore power to the SCADAPack Vision-10,
Release the keys when the message “Initializing Memory…” message
appears in the display. The initialization is complete when the “CMI
VISION-10” message is displayed.

Download Configuration File to SCADAPack Vision-10
Once the configuration file has been created, it must be written or
“downloaded” to the PLC. The file is downloaded from the computer RS232 serial port, through a null modem cable to the SCADAPack Vision-10
Serial port.
To download the configuration file to the SCADAPack Vision-10:
Connect a three-wire, null modem cable (see Figure 13: SCADAPack
Vision-10 Serial Port to Computer Serial Port Connection) from the
computer RS-232 serial port to the SCADAPack Vision-10 Serial Port.
In the SCADAPack Vision configuration software, from the Communicate
menu, select the Communication Port command.
Select the appropriate com port for the computer from the Communication
Port dialog list that is displayed.
Select Ok to accept the configuration and close the dialog.
From the Communicate menu, select the Download command. The
following dialog appears:
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With the Application radio button selected, select the Ok button to begin
the download.
As the download proceeds, a red line moving from the computer graphic
towards the SCADAPack Vision-10 graphic indicates the progress.
A dialog appears when the download is completed.
Select Ok to close the dialog.

SCADAPack Vision-50 Program Development
This section of the manual is organized in a manner that will lead the new
user through the steps required to create a SCADAPack Vision-50
configuration file and download the file to the SCADAPack Vision-50
operator interface. It is recommended that new users follow the steps
outlined in this section.
Open SCADAPack Vision Software
Create New Configuration File
Configure Network Configuration
Configure Tags
Configure Screens
Configure Application Task List
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Save the Configuration file
Download Configuration File to SCADAPack Vision-50
Connect SCADAPack Vision-50 to PLC
The SCADAPack Vision-50 operator interface displays PLC register data
and provides operators with the ability to write data to the PLC. A
SCADAPack Vision configuration file must be created and downloaded to
the SCADAPack Vision-50 operator interface in order to utilize the
SCADAPack Vision-50 operator interface.
The SCADAPack Vision configuration that will be created in this example
procedure will contain one display screen and it will be example for
scaling using SCADAPack Vision-50.
This section of the manual assumes that you have configured a
SCADAPack Series PLC (or similar) to be polled as a Modbus slave by
the SCADAPack Vision-50.
The SCADAPack Vision Configuration Software section contains detailed
explanations for all the commands and functions described in this section.
Follow the steps outlined below to configure the SCADAPack Vision-50
and download the file to the operator interface.
Open SCADAPack Vision Software
From the START | PROGRAMS | Vision menu, select the SCADAPack
Vision icon to open the configuration software.
Create New Configuration File
From the File menu, select New. A graphic of the SCADAPack Vision-10
and SCADAPack Vision-50 is displayed.
Click on SCADAPack Vision-50 icon to choose the SCADAPack Vision50 configuration and close the dialog by clicking on the Ok button.
Configure Network Configuration
The Network Configuration dialog is used to identify the PLC with which
the SCADAPack Vision will communicate.
From the Define menu, select Network Configuration. The following dialog
appears:
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Select the Add a node button. The four data entry fields are filled as
follows:
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The settings that are displayed configure the SCADAPack Vision-50 to
communicate with a SCADAPack Series controller, station address 1.
Select Ok to accept these settings and close the dialog.
Select the Close button to accept the Network Configuration settings and
close the dialog.
Configure Tags
A “Tag” is an identifying name given to each data point that is to be read
from or written to the PLC.
The four types of SCADAPack PLC data registers supported by the
SCADAPack Vision-50 are:
Coils, (SCADAPack 0XXXX series)
Input status, (SCADAPack 1XXXX series)
Input registers, (SCADAPack 3XXXX series) and
Holding registers (SCADAPack 4XXXX series).
To configure tags:
From the Define menu, select the Tag Database command. The following
dialog appears:
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In the Node data field, select the “[001: Node1 ] Control Microsystems
(SCADAPack)” entry. This action allows for the configuration of tags
related to the IO database addresses found in the SCADAPack PLC.
Select “Holding Registers” in the Read-Write data field.
Select “2-Bytes (1-Word)” in the Byte(s) field.
With “01001” displayed in the [00001 –09999] field and the Register TagType radio button selected, enter “SCALE Register” in the Tag-Name
field.
Select the Add button. A tag named “SCALE Register” is created which is
associated with the SCADAPack IO database addresses 41001 and
41002.
When completed, the Tags dialog should appear like this:

Select the Close button to save the configured tags and close the dialog.
Configure Screens
PLC data associated with tags is displayed on the SCADAPack Vision50’s LCD by configuring “screens”.
To configure screens:
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From the Define menu, select the Screens command. The following
dialog is displayed:

Select the Ok button to accept these settings for Screen 1. The following
display is displayed in the middle of the screen configuration display. This
display correlates to the actual LCD on the SCADAPack Vision-50.

From the Objects | Alphanumeric Objects menu, select the Text
command. The cursor changes to the Text cursor.
With the Text cursor, select the upper left corner of the top line of the
screen display. Then click and drag to the lower right corner of the top
line of the screen display. Release the mouse button.
At the flashing cursor box, enter the text as displayed in the following
screen:
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From the Objects | Alphanumeric Objects menu, select the Display PLC
Data command. The cursor changes to the Display Data cursor.
With the Display Data cursor, click on the position 16 of the 2nd line of the
screen display. When “Display dialog” appear on the screen select
settings as shown on the below and click on Ok button. Note that 1stoperation and 2nd operation are set for the “NOP”.

From the Objects | Alphanumeric Objects menu, select the Display PLC
Data command. The cursor changes to the Display Data cursor.
With the Display Data cursor, click on the position 16 of the 3rd line of the
screen display. When “Display dialog” appear on the screen select
settings as shown on the below and click on Ok button. Note that 1stoperation is set to multiplying by 100 and 2nd operation for division by
32760. Display format is set for the 3 characters because output will go
from 0 to 100.
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From the Objects | Alphanumeric Objects menu, select the Bargraph
command. The cursor changes to the Display Data cursor.
With the Display Data cursor, click on the position 1 of the 4th line of the
screen display. When “Display dialog” appear on the screen select
settings as shown on the below and click on Ok button.

Adjust the size of the bargraph so that after all this entries you can see
following screen:
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From the Screen objects menu, select the “Tasklist of Screen” command.
When “Display dialog” appear on the screen add tasks as shown below
and click on Close button. Use “Select a Task to add” list to add the tasks.

Configure Application Task List
In this example, Screen 1 will be automatically displayed each time power
is applied to the SCADAPack Vision-50. This is accomplished with the
Application Task List.
From the Define menu, select the Application Tasklists command and
“Application …” dialog box will appear.
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With the Power-0n Tasks radio button selected, choose “Goto Screen” in
the Select a Task to add field.
From the Goto Screen dialog list that appears, select “00001 Screen1”.
Select Ok to accept the configuration and close the dialog. When
completed, the dialog should appear like this

Select the Close button to accept the configuration and close the dialog.
Save the Configuration file
The SCADAPack Vision-50 configuration, completed with steps 1 to 6,
can be saved to a configuration file for future use. The file has the “pzm”
file extension.
To save the configuration file
From the File menu, select the Save as command.
Change the entry in the File name field to “demo50.pzm”.
Using the Save in field and the file folder list, locate a suitable hard drive
or server location to save the configuration file.
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Select the Save button to save the configuration file and close the dialog.
Connect SCADAPack Vision-50 to PLC
In order for the SCADAPack Vision-50 operator interface to communicate
with the PLC, a special null modem cable has to be used. This cable must
provide 5VDC on pin 9 to power the SCADAPack Vision-50. The
SCADAPack series of controllers provides the required power on pin 9.
To connect the SCADAPack Vision-50 to the PLC
Configure a four-wire null modem cable, (see Figure 19: SCADAPack
Vision-50 PLC Port to SCADAPack Serial Port Connection).
Connect the cable from the SCADAPack Vision-50 PLC Port to the PLC
serial port. As soon as the connection is made, the LCD display on the
SCADAPack Vision-50 should illuminate and the downloaded application
should function. If the SCADAPack Vision-50 does not power up, check
that 5VDC is present on pin 9 of the SCADAPack Vision-50 to PLC Port
cable.
Initialize SCADAPack Vision-50
Initializing the SCADAPack Vision-50 erases the previously downloaded
application and initializes the SCADAPack Vision-50 memory. To initialize
the SCADAPack Vision-50:
Remove power to the SCADAPack Vision-50,
Press and hold the F5[HOME] and ENT keys simultaneously,
Restore power to the SCADAPack Vision-50,
Release the keys when the message “Initializing Memory…” message
appears in the display. The initialization is complete when the “VISION50” message is displayed.
Download Configuration File to SCADAPack Vision-50
Once the configuration file has been created, it must be written or
“downloaded” to the PLC. The file is downloaded from the computer RS232 serial port, through a null modem cable to the SCADAPack Vision-50
Serial port.
To download the configuration file to the SCADAPack Vision-50:
Connect a three-wire, null modem cable (see Figure 23: SCADAPack
Vision-50 Serial Port to Computer Serial Port Connection) from the
computer RS-232 serial port to the SCADAPack Vision-50 Serial Port.
In the SCADAPack Vision configuration software, from the Communicate
menu, select the Communication Port command.
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Select the appropriate com port for the computer from the Communication
Port dialog list that is displayed.
Select Ok to accept the configuration and close the dialog.
From the Communicate menu, select the Download command. The
following dialog appears:

With the Application radio button selected, select the Ok button to begin
the download.
As the download proceeds, a red line moving from the computer graphic
towards the SCADAPack Vision-50 graphic indicates the progress.
A dialog appears when the download is completed.
Select Ok to close the dialog.

SCADAPack Vision-60 Program Development
This section of the manual is organized in a manner that will lead the new
user through the steps required to create a SCADAPack Vision-60
configuration file and download the file to the SCADAPack Vision-60
operator interface. It is recommended that new users follow the steps
outlined in this section.
Open SCADAPack Vision Software
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Create New Configuration File
Configure Network Configuration
Configure Tags
Configure Screens
Configure Application Task List
Save the Configuration file
Download Configuration File to SCADAPack Vision-60
Connect SCADAPack Vision-60 to PLC
The SCADAPack Vision-60 operator interface displays PLC register data
and provides operators with the ability to write data to the PLC. A
SCADAPack Vision configuration file must be created and downloaded to
the SCADAPack Vision-60 operator interface in order to utilize the
SCADAPack Vision-60 operator interface.
The SCADAPack Vision configuration that will be created in this example
procedure will contain one display screen and it will be example for
scaling using SCADAPack Vision-60.
This section of the manual assumes that you have configured a
SCADAPack Series PLC (or similar) to be polled as a Modbus slave by
the SCADAPack Vision-60.
The SCADAPack Vision Configuration Software section contains detailed
explanations for all the commands and functions described in this section.
Follow the steps outlined below to configure the SCADAPack Vision-60
and download the file to the operator interface.
Open SCADAPack Vision Software
From the START | PROGRAMS | Vision menu, select the SCADAPack
Vision icon to open the configuration software.
Create New Configuration File
From the File menu, select New. A graphic of the SCADAPack Vision-10,
SCADAPack Vision 50 and SCADAPack Vision-60 is displayed.
Click on SCADAPack Vision-60 icon to choose the SCADAPack Vision60 configuration and close the dialog by clicking on the Ok button.
Configure Network Configuration
The Network Configuration dialog is used to identify the PLC with which
the SCADAPack Vision will communicate.

SCADAPack Vision User Manual 11/10/2011

88

SCADAPack Vision Configuration Software
From the Define menu, select Network Configuration. The following dialog
appears:

Select the Add a node button. The four data entry fields are filled as
follows:
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The settings that are displayed configure the SCADAPack Vision-60 to
communicate with a SCADAPack Series controller, station address 1.
Select Ok to accept these settings and close the dialog.
Select the Close button to accept the Network Configuration settings and
close the dialog.
Configure Tags
A “Tag” is an identifying name given to each data point that is to be read
from or written to the PLC.
The four types of SCADAPack PLC data registers supported by the
SCADAPack Vision-60 are:
Coils, (SCADAPack 0XXXX series)
Input status, (SCADAPack 1XXXX series)
Input registers, (SCADAPack 3XXXX series) and
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Holding registers (SCADAPack 4XXXX series).
To configure tags:
From the Define menu, select the Tag Database command. The following
dialog appears:

In the Node data field, select the “[001: Node1 ] Control Microsystems
(SCADAPack)” entry. This action allows for the configuration of tags
related to the IO database addresses found in the SCADAPack PLC.
Select “Holding Registers” in the Read-Write data field.
Select “2-Bytes (1-Word)” in the Byte(s) field.
With “01001” displayed in the [00001 –09999] field and the Register TagType radio button selected, enter “SCALE Register” in the Tag-Name
field.

SCADAPack Vision User Manual 11/10/2011

91

SCADAPack Vision Configuration Software
Select the Add button. A tag named “SCALE Register” is created which is
associated with the SCADAPack IO database addresses 41001 and
41002.
When completed, the Tags dialog should appear like this:

Select the Close button to save the configured tags and close the dialog.
Configure Screens
PLC data associated with tags is displayed on the SCADAPack Vision60’s LCD by configuring “screens”.
To configure screens:
From the Define menu, select the Screens command. The following
dialog is displayed:
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Select the Ok button to accept these settings for Screen 1. The following
display is displayed in the middle of the screen configuration display. This
display correlates to the actual LCD on the SCADAPack Vision-60.

From the Objects | Alphanumeric Objects menu, select the Text
command. The cursor changes to the Text cursor.
With the Text cursor, select the upper left corner of the top line of the
screen display. Then click and drag to the lower right corner of the top
line of the screen display. Release the mouse button.
At the flashing cursor box, enter the text as displayed in the following
screen:
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From the Objects | Alphanumeric Objects menu, select the Display PLC
Data command. The cursor changes to the Display Data cursor.
With the Display Data cursor, click on the position 16 of the 2nd line of the
screen display. When “Display dialog” appear on the screen select
settings as shown on the below and click on Ok button. Note that 1stoperation and 2nd operation are set for the “NOP”.

From the Objects | Alphanumeric Objects menu, select the Display PLC
Data command. The cursor changes to the Display Data cursor.
With the Display Data cursor, click on the position 16 of the 3rd line of the
screen display. When “Display dialog” appear on the screen select
settings as shown on the below and click on Ok button. Note that 1stoperation is set to multiplying by 100 and 2nd operation for division by
32760. Display format is set for the 3 characters because output will go
from 0 to 100.
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From the Objects | Alphanumeric Objects menu, select the Bargraph
command. The cursor changes to the Display Data cursor.
With the Display Data cursor, click on the position 1 of the 4th line of the
screen display. When “Display dialog” appear on the screen select
settings as shown on the below and click on Ok button.

Adjust the size of the bargraph so that after all this entries you can see
following screen:
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From the Screen objects menu, select the “Tasklist of Screen” command.
When “Display dialog” appear on the screen add tasks as shown below
and click on Close button. Use “Select a Task to add” list to add the tasks.

Configure Application Task List
In this example, Screen 1 will be automatically displayed each time power
is applied to the SCADAPack Vision-60. This is accomplished with the
Application Task List.
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From the Define menu, select the Application Tasklists command and
“Application …” dialog box will appear.
With the Power-0n Tasks radio button selected, choose “Goto Screen” in
the Select a Task to add field.
From the Goto Screen dialog list that appears, select “00001 Screen1”.
Select Ok to accept the configuration and close the dialog. When
completed, the dialog should appear like this

Select the Close button to accept the configuration and close the dialog.
Save the Configuration file
The SCADAPack Vision-60 configuration, completed with steps 1 to 6,
can be saved to a configuration file for future use. The file has the “pzm”
file extension.
To save the configuration file
From the File menu, select the Save as command.
Change the entry in the File name field to “demo60.pzm”.
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Using the Save in field and the file folder list, locate a suitable hard drive
or server location to save the configuration file.
Select the Save button to save the configuration file and close the dialog.
Connect SCADAPack Vision-60 to PLC
In order for the SCADAPack Vision-60 operator interface to communicate
with the PLC, a special null modem cable has to be used. This cable must
provide 5VDC on pin 9 to power the SCADAPack Vision-60. The
SCADAPack series of controllers provides the required power on pin 9.
To connect the SCADAPack Vision-60 to the PLC
Configure a four-wire null modem cable, (see Figure 29: SCADAPack
Vision-60 PLC Port to SCADAPack Serial Port Connection).
Connect the cable from the SCADAPack Vision-60 PLC Port to the PLC
serial port. As soon as the connection is made, the LCD display on the
SCADAPack Vision-60 should illuminate and the downloaded application
should function. If the SCADAPack Vision-60 does not power up, check
that 5VDC is present on pin 9 of the SCADAPack Vision-60 to PLC Port
cable.
Initialize SCADAPack Vision-60
Initializing the SCADAPack Vision-60 erases the previously downloaded
application and initializes the SCADAPack Vision-60 memory. To initialize
the SCADAPack Vision-60:
Remove power to the SCADAPack Vision-60,
Press and hold the F5[HOME] and ENT keys simultaneously,
Restore power to the SCADAPack Vision-60,
Release the keys when the message “Initializing Memory…” message
appears in the display. The initialization is complete when the “VISION60” message is displayed.
Download Configuration File to SCADAPack Vision-60
Once the configuration file has been created, it must be written or
“downloaded” to the PLC. The file is downloaded from the computer RS232 serial port, through a null modem cable to the SCADAPack Vision-60
Serial port.
To download the configuration file to the SCADAPack Vision-60:
Connect a three-wire, null modem cable (see Figure 33: SCADAPack
Vision-60 Serial Port to Computer Serial Port Connection) from the
computer RS-232 serial port to the SCADAPack Vision-60 Serial Port.
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In the SCADAPack Vision configuration software, from the Communicate
menu, select the Communication Port command.
Select the appropriate com port for the computer from the Communication
Port dialog list that is displayed.
Select Ok to accept the configuration and close the dialog.
From the Communicate menu, select the Download command. The
following dialog appears:

With the Application radio button selected, select the Ok button to begin
the download.
As the download proceeds, a red line moving from the computer graphic
towards the SCADAPack Vision-60 graphic indicates the progress.
A dialog appears when the download is completed.
Select Ok to close the dialog.
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The SCADAPack Vision is compact, panel-mounted operator interface
terminal for programmable logic controllers.
The SCADAPack Vision configuration software is used to configure the
SCADAPack Vision operator interface to display data read from the PLC
and to allow operator-entered data to be written to the PLC.
This section of the manual describes each of the SCADAPack Vision
configuration commands available from the SCADAPack Vision menu
bar. The user is encouraged to read through the following sections to gain
an understanding of the many programming features available.

File Menu
The File menu contains commands to create, open, and save
SCADAPack Vision configuration files.
New
The New command opens a new SCADAPack Vision configuration file for
the SCADAPack Vision operator interface, the SCADAPack PLC is
chosen as the default PLC, the network configuration contains the
SCADAPack Vision, the tag database is cleared, all screens are deleted
and all key functions are reset.
If the current file has not been saved, the program warns you to save the
current file. You may save the changes, discard the changes or cancel
the New command.
Open
The Open command loads a SCADAPack Vision configuration file from
disk into the program. The file replaces the existing file in the editor. If the
current file has not been saved, the editor warns you to save the current
file. You may save the changes, discard the changes or cancel the Open
command.
The Open command displays the Open File dialog box. This dialog box is
used to select the file to open. SCADAPack Vision configuration files end
with the file extension PZM. The dialog box displays these files by default.
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Close
The Close command closes the currently open configuration file without
closing the SCADAPack Vision program.
If the current file has not been saved, the program warns you to save the
current file. You may save the changes, discard the changes or cancel
the Close command.
Pressing Ctrl-F4 selects the Close command from the keyboard.
Save
The Save command stores the currently open file on disk. If the current
file has not yet been named, the Save Vision Application dialog box
appears. The file name and working directory can be selected from this
dialog box. The title bar at the top of the editor window shows the current
file name.
Pressing F2 selects the Save command from the keyboard.
Save as
The Save as command stores a file with a different name or location than
the current file. The Save Vision Application dialog box is used to specify
the file name and directory in which to save the file.
SCADAPack Vision configuration files end with the file extension PZM.
The editor uses the extension PZM automatically, if you do not type it.
Information
The Information command displays application information in the
following dialog.
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This dialog is used to add pertinent configuration file information for future
reference.
The Title field allows for the entry of an application title containing up to a
maximum of 50 alphanumeric characters plus spaces.
The Author field allows for the entry of the integrator’s name containing
up to a maximum of 50 alphanumeric characters plus spaces.
The Date last edited field contains the date when the currently open
application file was last saved.
The Time last edited field contains the time when the currently open
application file was last saved.
The Description field allows for the entry of descriptive text containing up
to a maximum of 500 alphanumeric characters plus spaces.
Exit
The Exit command terminates the SCADAPack Vision configuration
program. The editor warns you to save the current file, if it had changed
since the last save. You may save the changes, throw away the changes
or cancel the Exit command.
Press Alt-F4 to select the Exit command from the keyboard.
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Define Menu
The Define menu contains commands to define SCADAPack Vision
settings, network configuration, tags, screens, application keys, alarms
and application tasklists.
Vision Settings
The SCADAPack Vision’s Settings command defines the SCADAPack
Vision’s polling parameters and floating-point-variable format settings.
The command opens the Vision’s settings dialog.

Except for the polling parameters and floating-point variable format, other
settings are disabled and do not have to be adjusted.
Note: A printer port is not available on the SCADAPack Vision-10 and
SCADAPack Vision-60. The Printer Port Options are therefore not
supported.
Network Configuration
The Network Configuration command defines the Modbus station address
for the SCADAPack Vision and the PLC. The command opens the
Network Configuration dialog.
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Select the Add a node button to add a PLC to the network configuration.
Enter the Modbus station address into the Node Address field. Valid
addresses are 1 to 255. The default is 1.
Enter a node name into the Node Name field. A maximum of 15
alphanumeric characters are allowed. The default is Node1.
Choose a PLC manufacturer from the PLC selection field. The default is
Control Microsystems.
Choose a PLC model from the PLC Model selection field. The default is
SCADAPack.
Click on OK to add node to the list or Cancel button to cancel operation
Select the Delete the node command to delete the currently selected
node. The SCADAPack Vision Series node cannot be deleted.
The Close command saves the current settings and closes the dialog.
The Help command displays the on-line help for the dialog.
When Control Microsystems (SCADAPack) has been selected, the
Special PLC Data button becomes active. Select the Special PLC Data
command to open the Special PLC Data dialog.
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This dialog configures the communication parameters for the PLC port.
The Baud Rate edit field allows for the selection of 4800, 9600 or 19200
baud. The default is 9600.
The Parity edit field allows for the selection of Odd, Even or None parity.
The default is None.
The Data Bits are fixed at 8.
The Stop Bits are fixed at 1.
The Ok button accepts changes made to the current configuration and
closes the dialog.
The Close button discards changes made to the current configuration and
closes the dialog.
The Help button displays information for the dialog.
Tag Database
The Tag Database command defines the tag database. A “tag” is an
identifying name used by the SCADAPack Vision that is given to each
data point to be read from, or written to, the PLC. The command opens
the Tags dialog.
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The Node selection field contains the SCADAPack Vision and a list of
PLCs configured in the Network Configuration dialog. To create tags
internal to the SCADAPack Vision, select Vision – unit. To create tags to
allow the SCADAPack Vision to read/write to the SCADAPack PLC,
select Control Microsystems (SCADAPack).
The Read – Write selection field contains the types of data supported by
the device that appears in the Node field.
There are two types of internal SCADAPack Vision registers: Data
Registers and Retentive Registers.
Data Registers, (address range 0000 to 0127).
Values contained in the registers reside in the SCADAPack Vision only.
Data Register values are reset to zero upon SCADAPack Vision powerup.
There are four reserved Data Registers: D0124 to D0127.
D0124: The “While Showing Tasks” Data Register provides delays
between the execution of tasks configured in the “While Showing Tasks”
lists. Valid values are 0 to 255 in 20 msec increments. For example, a 1
sec delay requires a value of 50 for D0124.
D0125: The “Global Tasks” Data Register provides delays between the
execution of tasks configured in the “Global Tasks” list. Valid values are 0
to 255 in 20 msec increments. For example, a 1 sec delay requires a
value of 50 for D0125.
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D0126: The “Read Alarm” Data Register provides delays between
attempts to read configured alarms. Valid values are 0 to 255 in 20
msec increments. For example, a 1 sec delay requires a value of 50 for
D0126.
D0127: The “Read Data Blocks” Data Register provides delays between
attempts to read blocks of data from the SCADAPack Vision and
PLC. Valid values are 0 to 255 in 20 msec increments. For example, a 1
sec delay requires a value of 50 for D0127.
Retentive Registers, (address range 0000 to 0999).
Retentive Registers retain their values upon SCADAPack Vision powerup.
There are four types of SCADAPack PLC data registers: Coil, Input
Status, Input Registers and Holding Registers. Values contained in these
registers are written to or read from the PLC.
Coil (address range 00001 to 04089),
Input status (address range 10001 to 14089),
Input register (address range 30001 to 31024) and
Holding register (40001 to 49999).
The Tag – Type radio-button field allows for the selection of either a
Register tag type or Coil or Bit-addressed Register tag-type. The datatype displayed in the Read – Write field determines which Tag – Type
radio button is active.
The register or coil Size: field displays the number of bits or bytes used by
the register. The Modbus address is displayed just below. Note: a leading
“0” is placed in the Modbus address. This differs from the SCADAPack IO
database register numbering convention. For example, SCADAPack
Vision tag address 300001 is synonymous with SCADAPack IO database
address 30001.
To the right of the register or coil Size: field, the range of valid address
points is displayed. Just below this is a field to allow for the selection of
the address. This address is offset from the base address for the datatype selected in the Read – Write field. For example, entering a data-type
of Holding Registers in the Read – Write field, and a value of 100 in the
address selection field results in a Modbus register of 400100. This is
synonymous with the SCADAPack IO database address 40100.
The Tag-Name field allows for the configuration of the tag name. Tag
names may consist of up to a maximum of forty alphanumeric characters
and spaces. The Byte(s) field allows for the configuration of the number of
bytes corresponding to the register. Valid entries are single-byte, two-byte
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(one word), four-byte (two words) or eight-byte (four words) data
registers. This field is left blank if the Read – Write field contains either
Coil or Input status.
The Close command saves the current settings and closes the dialog.
The Help command displays the on-line help for the dialog.
The Network Configuration button opens the Network
Configuration dialog.
The Delete Tag button deletes the tag that is currently selected in
the display list.
The Add button adds the tag name that is currently displayed in the TagName field to the tag database. Each tag must have a unique name and
register address. If there is any tag name conflict, an error message is
displayed.
The Change button allows for the changing of any configuration
parameters for the tag that is currently highlighed in the display list. If
there are no tags highlighted in the display list, the button is greyed.
The Cancel command discards all configuration changes and closes the
dialog.
Screens
The Screens command defines the data display/entry screens and local
application keys.
New Screens Dialog
When first accessing the Screens command, the New Screen dialog is
opened. Refer to the New command in the Screens menu for more
information.
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Screen Configuration Dialog
The Screen configuration dialog contains commands used to create and
edit data display screens. These commands are grouped into three
toolbars. The actual screen display is represented as an edit box.
The dialog for the SCADAPack Visions are identical with exception for the
screen size and it has the following layout.
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Menu Bar
In addition to the default menu commands, the Screen Configuration
dialog activates three additional menu commands, Screen, Objects and
Tools. These menu commands are available only when the Screen
Configuration dialog is the active dialog. Refer to section 7.5-Screen
Menu, 7.6-Objects Menu, and 7.7-Tools Menu for information.
Screen Toolbar
The Screen toolbar contains the following commands.
New Screen:
Opens the New Screen dialog. This is the same as
the New command in the
Screen menu.
Delete Screen: Deletes the current screen. This is the same as the
Delete command in the Screen menu.
Duplicate Screen:
Creates a duplicate copy of the current
screen. This is the same as the Duplicate command in the Screen menu.
Screen Information:
Displays additional screen information. This
is the same as the Screen Information command in the Screen menu.
All Screens:
Displays all the screens simultaneously. This is the
same as the View All Screens command in the Screen menu.
Select Screen: Selects a screen. This is the same as the Select
Screens command in the Screen menu.
Screen Keys:
Configures local application keys. This is the same
as the Keys for Screen command in the Screen menu.
Screen Tasklists: Configures local tasklists. This is the same as the
Task-lists of Screen command in the Screen menu.
Zoom In: Zooms into the Screen Display Edit Box. This is the same
as the Zoom In command in the Screen menu.
Zoom Out:
Zooms out from the Screen Display Edit Box. This
is the same as the Zoom Out command in the Screen menu.
Alphanumeric Grid:
Displays alphanumeric grid in Screen
Display Edit Box. This is the same as the Show/Hide Alphanumeric Grid
command in the Screen menu.
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Character Set: Displays the character set for text-display objects.
This is the same as the Character Set command in the Screen menu.
Objects & Properties Toolbar
The Objects & Properties toolbar contains the following commands.
Selector: Selects objects on the Screen Display Edit Box. This is the
same as the Selector command in the Objects menu.
Text:
Inserts text-display objects into the Screen Display Edit
Box. This is the same as the Text command in the Objects |
Alphanumeric Objects menu.
Data Entry:
Inserts data entry fields into the Screen Display Edit
Box. This is the same as the Data Entry command in the Objects |
Alphanumeric Objects menu.
Display Data:
Inserts SCADAPack Vision or PLC data-display
fields into the Screen Display Edit Box. This is the same as the Display
PLC Data command in the Objects | Alphanumeric Objects menu.
Bargraph: Inserts bargraph display field into the Screen Display Edit
Box. This is the same as the Bargraph command in the Objects |
Alphanumeric Objects menu.
Alarm(s): Inserts alarm display field into the Screen Display Edit Box.
This is the same as the Alarm command in the Objects | Alphanumeric
Objects menu.
Flash:
Configures flash properties of text and data-display fields.
This is the same as the Flash command in the Objects menu.
Animation:
Configures animation properties of text and datadisplay fields. This is the same as the Animation Properties command in
the Objects menu.
Tools Toolbar
The Tools toolbar contains the following commands.
Undo:
Un-does the previous action. This is the same as the Undo
command in the Tools menu.
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Redo:
Re-does the previous Undo action. This is the same as the
Redo command in the Tools menu.
Select All: Selects all objects in the Screen Display Edit Box. This is
the same as the Select All command in the Tools menu.
Cut:
Cuts selected objects from the Screen Display Edit Box
into the memory buffer. This is the same as the Cut command in the
Tools menu.
Copy:
Copies selected objects from the Screen Display Edit Box
into the memory buffer. This is the same as the Copy command in the
Tools menu.
Paste:
Pastes objects from the memory buffer into the Screen
Display Edit Box. This is the same as the Paste command in the Tools
menu.
Screen Display Edit Box
The Screen Edit Display Box is used to configure the SCADAPack Vision
display screens. Configured objects appear exactly on the SCADAPack
Vision display screen as they appear in the Screen Edit Display Box.. A
snap grid may be superimposed on the box and the box may be zoomed
into or away from.
To close the entire Screen-editing session, select the
button. This is
the same as the Close Screens session command in the Screen menu.
Global Keys
The Global Keys command defines the “global” action of keys. “Global”
refers to all screens. Actions configured in this dialog affect a key’s action
on all screens, unless local actions have been configured. The command
opens the Global Keys’ Task-lists dialog.
Configurable Keys for SCADAPack Vision-10
The configurable keys are labeled F1 through F6 and NEXT, PREV, Left
Arrow, Up Arrow, CLR and ENT.
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The default configuration for these keys is as follows:
F1

NEXT (Go to next screen)

F2

PREV (Go to previous screen)

F3

Left Arrow (shift value to the left)

F4

Up Arrow (increase digit by 1)

F5

CLR (clear data entry)

F6

ENT (accept data entry)

Configurable Keys for SCADAPack Vision-50
All keys on the SCADAPack Vision-50 are configurable.
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The default configuration for these keys is as follows:
F1

NEXT (Go to next screen)

F2

PREV (Go to previous screen)

F3

Left Arrow (Move Cursor to Left)

F4

Right Arrow (Move Cursor to Right)

F5

HOME (Go to Screen 1)

F6

ACK (Acknowledge Alarm)

F7

Up Arrow (Increase Digit by 1)

F8

Down Arrow (Decrease Digit by 1)
ESC (Cancel Data Entry)
ENT (Accept Data Entry)
0+/- (Sign Key +/- and 0)
1-9 (Numeric Keys 1-9)

Configurable Keys for SCADAPack Vision-60
All keys on the SCADAPack Vision-60 are configurable.
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The default configuration for these keys is as follows:
F1

NEXT (Go to next screen)

F2

PREV (Go to previous screen)

F3

Left Arrow (Move Cursor to Left)

F4

Right Arrow (Move Cursor to Right)

F5

HOME (Go to Screen 1)

F6

ACK (Acknowledge Alarm)

F7

Up Arrow (Increase Digit by 1)

F8

Down Arrow (Decrease Digit by 1)
ESC (Cancel Data Entry)
ENT (Accept Data Entry)
0+/- (Sign Key +/- and 0)
1-9 (Numeric Keys 1-9)

Key Combination
The Single Key radio button configures an action to be controlled by a
single key.
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The Two simultaneous keys radio button configures an action to be
controlled by two simultaneously pressed keys.
Undefined Global key: Indicates that the global key is undefined.
The Select a Task to add field is used to select one of 18 available tasks.
Refer to section 7.9-Key Task Definitions section for a detailed
explanation of these tasks.
The ‘Press’ Tasks radio button activates the ‘Press’ Tasks list. Tasks
selected in the Select a Task to add field are placed in this list if the
‘Press’ Tasks radio button is first selected. ‘Press’ Tasks are executed
one time when the key is pressed and in the order that they appear in the
list.
The While ‘Pressed’ Tasks radio button activates the While ‘Pressed’
Tasks list. Tasks selected in the Select a Task to add field are placed in
this list if the While ‘Pressed’ Tasks radio button is first selected. While
‘Pressed’ Tasks are executed continually while the key is pressed and in
the order that they appear in the list.
The ‘Released’ Tasks radio button activates the ‘Released’ Tasks list.
Tasks selected in the Select a Task to add field are placed in this list if the
‘Released’ Tasks radio button is first selected. ‘Released’ Tasks are
executed one time when the key is released and in the order that they
appear in the list.
Move Task Up:
position up the list.
Move Task Down:
one position down the list.
Delete Task:

Moves the currently selected task one

Moves the currently selected task

Deletes the currently selected task.

The Close command accepts changes to the configuration and closes the
dialog.
The Help command displays the on-line help for the dialog.
Alarms
The Alarms command defines up to 31 alarms. Individual bits in singleword registers trigger these alarms. Once triggered, an alarm message is
displayed on a SCADAPack Vision screen in a FIFO (First In First Out)
queue. The alarm can be acknowledged with a globally or locally defined
key task.
The command opens the Alarms dialog.
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Alarms are defined on any single bit of any one-word (16-bit) tag. All the
tags must be defined before defining the alarms.
Alarms can be set on one type of tag only: Discrete.
The Groups of Alarms selection field allows for the selection of one of two
available groups of alarms. Group 01 consists of alarms 000 to 015 and
group 02 consists of alarms 016 to 030.
The Tag of group selection field allows for the selection of the tag to be
associated with the group. Only Input Register and Holding Register tags
are listed.
The Alarm Number field displays which alarm in the selected group is
being configured.
The Alarm Text field allows for the entry of text to be displayed when the
alarm is active up to a maximum of 16 alphanumeric characters for
SCADAPack Vision-10, 20 alphanumeric characters for SCADAPack
Vision-50 and 40 alphanumeric characters for the SCADAPack Vision
60, with spaces.
The Ok command accepts the configuration and closes the dialog.
The Cancel command discards any changes to the configuration and
closes the dialog.
The Help command displays the on-line help for the dialog.
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Tags:

Displays the Tags dialog.

The Delete command deletes the selected alarm from the alarm list.
The Add command activates the alarm configuration fields.
The Accept command accepts the alarm configuration and adds the
alarm to the display list.
The Discard command discards the alarm configuration for the currently
edited alarm.
Application Tasklists
The Application Tasklists command opens the Application (Power-on and
Global) Task-lists dialog.

This dialog is used to configure Power-on and Global tasks. Power-on
tasks are executed once each time power is applied to the SCADAPack
Vision. Global tasks are executed continually while the SCADAPack
Vision is communicating with the attached PLC.
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The Select a Task to add field is used to select one of 18 available tasks.
Refer to section 7.9-Key Task Definitions for a detailed explanation of
these tasks.
The Power-on Tasks radio button activates the Power-on Tasks list.
Tasks selected in the Select a Task to add field are placed in this list if the
Power-on Tasks radio button is first selected. Tasks are executed in the
order that they appear in the list.
The Global Tasks radio button activates the Global Tasks list. Tasks
selected in the Select a Task to add field are placed in this list if the
Global Tasks radio button is first selected. Tasks are executed in the
order that they appear in the list.
Move Task Up:
the list.

Moves the currently selected task one position up

Move Task Down:
position down the list.
Delete Task:

Moves the currently selected task one

Deletes the currently selected task.

The Close command accepts the task list configuration and closes the
dialog.
The Help command displays the on-line help for the dialog.

Communicate
The Communicate menu is used to configure the PLC-to- SCADAPack
Vision communication parameters, to download SCADAPack Vision
firmware and download or upload application files to the SCADAPack
Vision.
Communication Port
The Communication Port command opens the Communication Port
dialog.
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This dialog is used to select the computer port through which the
application file is written to the SCADAPack Vision. Valid communication
ports are COM1, COM2, COM3, COM4, COM5 and COM6.
The OK command accepts the selection and closes the dialog.
The Cancel command discards the selection and closes the dialog.
The Help command displays the on-line help for the dialog.
Download
The Download command opens the Downloading from Computer to
SCADAPack Vision dialog.
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This dialog is used to write the currently open application file or firmware
to the SCADAPack Vision.
The Communication Port command opens the Communication Port
dialog. This is the same as the Communication Port command in the
Communicate menu.
Selecting the Firmware radio button downloads the firmware file, located
in the \Vision\drivers\ subdirectory, to the SCADAPack Vision when the
Ok command is selected. The firmware file has the file extension “.abs”.
Downloading firmware overwrites existing firmware in the SCADAPack
Vision.
If communication is disrupted during the firmware download procedure,
the SCADAPack Vision display will appear blank. Waiting 30 seconds or
cycling power to the SCADAPack Vision is required before attempting to
download the firmware again. If the SCADAPack Vision still does not
respond to the firmware download, the boot-loader may have been
corrupted. However, it may still be recoverable by following this
procedure:
SCADAPack Vision-10 firmware erase procedure:
Remove power to the SCADAPack Vision-10.
Press and hold the F1, F3 and F5 keys simultaneously and firmly.
Restore power to the SCADAPack Vision-10.
Keeping the keys pressed for at least three seconds, wait until a blank
screen appears (yellow backlight without characters). This screen may
contain spurious data on the upper LCD line.
Release all the three keys.
Press F2 within 15 seconds.
After approximately 10 seconds remove power to the SCADAPack Vision10.
Restore power to the SCADAPack Vision-10. It should now contain only
the boot-loader. The unit should now accept the firmware download.
SCADAPack Vision-60 firmware erase procedure:
Remove power to the SCADAPack Vision-60.
Press and hold the F5[HOME], F6 [ACK] and F7[Up-arrow] keys
simultaneously and firmly.
Restore power to the SCADAPack Vision-60.
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Keeping the keys pressed for at least three seconds, wait until a blank
screen appears (yellow backlight without characters). This screen may
contain spurious data on the upper LCD line.
Release all the three keys.
Press F1[NEXT] within 15 seconds.
After approximately 10 seconds remove power to the SCADAPack Vision60.
Restore power to the SCADAPack Vision-60. It should now contain only
the boot-loader. The unit should now accept the firmware download.
Selecting the Application radio button downloads the currently open
application file to the SCADAPack Vision when the Ok command is
selected. Downloading an application erases the application in the
SCADAPack Vision.
Download progress is indicated with a red line that moves from the
computer graphic to the SCADAPack Vision graphic.
The Ok command downloads (writes) either the firmware or application
file from the computer to the SCADAPack Vision depending on the radio
button selection.
The Close command closes the dialog.
The Help command displays the on-line help for the dialog. Selecting the
Application radio button downloads the currently open application file to
the SCADAPack Vision when the Ok command is selected. Downloading
an application erases the application in the SCADAPack Vision.
Download progress is indicated with a red line that moves from the
computer graphic to the SCADAPack Vision graphic.
The Ok command downloads (writes) either the firmware or application
file from the computer to the SCADAPack Vision depending on the radio
button selection.
The Close command closes the dialog.
The Help command displays the on-line help for the dialog.
Upload
The Upload command displays the Uploading from a SCADAPack Vision
to Computer dialog.
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This dialog is used to upload the application file from the SCADAPack
Vision to the computer. Applications currently open in the Vision
configuration software are over written by the uploaded application.
The Communication Port command opens the Communication Port
dialog. This is the same as the Communication Port command in the
Communicate menu.
The Ok command uploads (reads) application file from the SCADAPack
Vision to the computer.
The Close command closes the dialog.
The Help command displays the on-line help for the dialog.

Utilities Menu
The Utilities menu is used to add and remove PLCs from a list of
available PLC types and to display the memory configuration of the
currently open SCADAPack Vision application.
Add or Remove PLCs
Memory Configuration
The Memory Configuration command opens the Memory Configuration
dialog.
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This dialog displays the total available, used and free memory usage
statistics of the currently open application file. The memory usage by
definition type is also displayed.
This command is available only when an application is open.
The Ok command closes the dialog.

Screen Menu
The Screen menu contains commands to create, configure and edit datadisplay screens.
New
The New command is used to create new data-display screens. The
command opens the New Screen dialog.
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The Screen Number field defines a number for the new screen. Valid
screen numbers are 1 to 65534.
The Screen Name field defines a name for the screen. The name may
contain a maximum of twenty alphanumeric characters or spaces.
The Description field allows for the entry of descriptive text for the screen.
A maximum of one hundred alphanumeric characters may be entered.
The Password field defines a numeric pass code used to inhibit access to
the screen. Valid passwords are 0 to 9999, where 0 indicates that this
option is not used.
Associated Screens
Associated screens are useful in cases where one or more objects are
common between different screens. The common part is extracted from
all the screens, placed in a new screen and is then associated with the
other screens. Any screen can be associated to another screen.
The advantages of associating screens are:
Saving application memory by extracting common data between different
screens and forming a new associate screen.
Saving application-programming time.
Only one screen can be associated to any screen.
No data entry object can be placed in the screen to be associated.
No PLC tag may be embedded in the screen to be associated. To embed
a PLC tag, use a Global Task to copy the PLC tag to an internal
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SCADAPack Vision tag. The internal tag may then be embedded in the
screen to be associated.
The Associated Screens field defines the screen to be associated with the
current screen. The maximum quantity of associated screens is one.
The Available Screens field lists the screens that are available for
association with the current screen.
The < - Associate command moves entries from the Available Screens
field to the Associated Screens field.
The Unassociate command moves entries from the Associated Screens
field to the Available Screens field.
The Ok command accepts the configuration and closes the dialog.
The Cancel command discards all configuration changes and closes the
dialog.
The Help command displays the on-line help for the dialog.
Delete
The Delete command prompts the user to delete the currently displayed
screen.
Duplicate
The Duplicate command copies the properties of the currently displayed
screen to a new screen. The command opens the Duplicate Screen
dialog.
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This dialog is identical in appearance and functionality to the New Screen
dialog except for the addition of the Memory configuration of Screen
command. Refer to the New command in the Screens menu for more
information.
The Memory configuration of Screen command displays the memory
usage of the currently selected Available Screen.
Initialize
The Initialize command prompts the user to clear all elements from the
currently open screen. This command cannot be undone.
Screen Information
The Screen Information command displays the attributes for the currently
selected screen. The command opens the Screen Information dialog.

This dialog is identical in appearance and functionality to the New Screen
dialog except for the addition of the Memory configuration of Screen
command. Refer to the New command in the Screens menu for more
information.
The Memory configuration of Screen command displays the memory
usage of the currently selected Available Screen.
View All Screens
The View All Screens command displays all screens simultaneously,
allowing the user to select a screen to edit. The command opens the All
screens dialog.
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Double-clicking the mouse cursor on a particular screen displays that
screen for editing purposes and closes the All screens dialog.
Select Screens
The Select Screens command displays a list of all screen names,
allowing the user to select a screen to edit. The command opens the
Select Screen dialog.

Double-clicking the mouse cursor on a particular screen name displays
that screen for editing purposes and closes the Select Screen dialog.
The Ok command displays the currently selected screen and closes the
Select Screen dialog.
The Cancel command closes the Select Screen dialog without changing
screen focus.
The Help command displays the on-line help for the dialog.
Keys For Screen
The Keys For Screen command defines the “local” action of keys. “Local”
refers to only the currently displayed screen. Therefore, actions
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configured in this dialog affect a key’s action on the currently displayed
screen only. Local key action takes precedence over global key action.
Key action is defined using tasks. Tasks can be executed upon pressing
the key, while the key is held and when the key is released.
The command opens the Global Keys’ Task-lists dialog.
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The configuration of local keys is identical to that of global keys. Refer to
section 7.2.5-Global Keys for detailed information.
Global Keys:

Opens the Global Keys’ Task-lists dialog.

The Select a Task to add field is used to select one of 18 available tasks.
Refer to section 7.9-Key Task Definitions for a detailed explanation of
these tasks.
The ‘Press’ Tasks radio button activates the ‘Press’ Tasks list. Tasks
selected in the Select a Task to add field are placed in this list if the
‘Press’ Tasks radio button is first selected. ‘Press’ Tasks are executed
one time when the key is pressed and in the order they appear in the list.
The While ‘Pressed’ Tasks radio button activates the While ‘Pressed’
Tasks list. Tasks selected in the Select a Task to add field are placed in
this list if the While ‘Pressed’ Tasks radio button is first selected. While
‘Pressed’ Tasks are executed continually while the key is pressed and in
the order they appear in the list.
The ‘Released’ Tasks radio button activates the ‘Released’ Tasks list.
Tasks selected in the Select a Task to add field are placed in this list if the
‘Released’ Tasks radio button is first selected. ‘Released’ Tasks are
executed one time when the key is released and in the order they appear
in the list.
Move Task Up:
position up the list.
Move Task Down:
one position down the list.
Delete Task:

Moves the currently selected task one

Moves the currently selected task

Deletes the currently selected task.

The Close command accepts changes to the configuration and closes the
dialog.
The Help command displays the on-line help for the dialog.
Task-lists of Screen
The Task-lists of Screen command defines the actions that occur when a
particular screen is displayed. These actions are defined using tasks.
Tasks can be executed before the screen is displayed, while the screen is
displayed and after the screen is displayed.
The command opens the Task-lists of Screen dialog.
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The Select a Task to add field is used to select one of 18 available tasks.
Refer to the section 7.9-Key Task Definitions for a detailed explanation
of these tasks.
The ‘Before Showing’ Tasks radio button activates the ‘Before Showing’
Tasks list. Tasks selected in the Select a Task to add field are placed in
this list if the ‘Before Showing’ Tasks radio button is first selected. ‘Before
Showing’ Tasks are executed one time just before the screen is displayed
and in the order they appear in the list.
The ‘While Showing’ Tasks radio button activates the ‘While Showing’
Tasks list. Tasks selected in the Select a Task to add field are placed in
this list if the ‘While Showing’ Tasks radio button is first selected. ‘While
Showing’ Tasks are executed continually while the screen is displayed
and in the order they appear in the list.
The ‘After hiding’ Tasks radio button activates the ‘After hiding’ Tasks list.
Tasks selected in the Select a Task to add field are placed in this list if the
‘After hiding’ Tasks radio button is first selected. ‘After hiding’ Tasks are
executed one time just after leaving the screen and in the order they
appear in the list.
Move Task Up:
the list.

Moves the currently selected task one position up
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Move Task Down:
position down the list.
Delete Task:

Moves the currently selected task one

Deletes the currently selected task.

The Close command accepts changes to the configuration and closes the
dialog.
The Help command displays the on-line help for the dialog.
Zoom In
The Zoom In command increases the size of the screen display area in
the screen-editing dialog.
Zoom Out
The Zoom Out command decreases the size of the screen display area in
the screen-editing dialog.
Show Alphanumeric Grid
The Show Alphanumeric Grid command displays the alphanumeric grid.
This grid is a series of dots on the screen display indicating the location of
alphanumeric characters.
This command is available when the Hide Alphanumeric Grid command is
active.
Hide Alphanumeric Grid
The Hide Alphanumeric Grid command displays the alphanumeric grid.
This command is available when the Show Alphanumeric Grid command
is active.
Character Set
The Character Set command displays the available ASCII character set
for use as text. This command opens the Character Set dialog.
Characters are selected with the mouse cursor and are placed in the
screen display.
The ASCII characters represented by decimal 0 to 29, are displayed in
the dialog as underscored 0 to 29. All other characters are displayed in
the dialog, as they will appear on screen.
The command is available when the Text command is active and the
cursor is inside the Text-insert window.
The Character Set dialog is closed by either selecting the close-dialog X
icon, or by choosing another editing function.
SCADAPack Vision User Manual 11/10/2011

133

SCADAPack Vision Configuration Software Reference
Close Screens Session
The Close Screens Session command closes the entire screen-editing
display. This can also be accomplished by selecting the close-dialog X
icon on the screen display.

Objects Menu
The Objects menu contains commands to create/edit data-display, dataentry, text and alarm objects. These objects determine the functionality of
the SCADAPack Vision display screens.
Alphanumeric Objects
Text
The Text command defines a text string on the screen display. The text
string can be used to provide a short description of a data point or provide
operator-input instructions.
A maximum of 16 alphanumeric characters may be entered per line, for a
total of 32 characters per screen for SCADAPack Vision-10 or 20
alphanumeric characters per line, for a total of 80 characters per screen
for SCADAPack Vision-60.
Selecting this command activates the Text cursor. This cursor is used to
point-and-drag a window in the screen display into which the text string is
typed.
Data Entry
The Data Entry command defines a data entry field on the screen display.
The data entry field allows an operator to enter information via the keys.
This information will then be written to the attached PLC.
A maximum of 16 alphanumeric characters may be entered per line, for a
total of 32 characters per screen for SCADAPack Vision-10 or 20
alphanumeric characters per line, for a total of 80 characters per screen
for SCADAPack Vision-60.
Selecting this command activates the Data Entry cursor. This cursor is
used to point-and-drag a window in the screen display.
Defining the Data Entry field location with the cursor opens the Data Entry
dialog.
This dialog defines the tag and data format to be associated with the Data
Entry object. The Type is set to Coil by default.
Selecting the Coil radio button displays edit fields used to define a coil
Data Entry object.
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The Coil-Tag selection field allows for the selection of a tag from a list of
all pre-defined coil-based tags.
The On Text edit field allows for the entering of a text string that is
displayed when the associated coil-based tag is ON. A maximum of 16
alphanumeric characters may be entered. The size of the pre-defined
point-and-drag window may also limit the length of the message.
The Off Text edit field allows for the entering of a text string that is
displayed when the associated coil-based tag is OFF. A maximum of 16
alphanumeric characters may be entered. The size of the pre-defined
point-and-drag window may also limit the length of the message.
Selecting the Register radio button displays edit fields used to define a
register Data Entry object.
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The Register-Tag selection field allows for the selection of a tag from a
list of all pre-defined register-based tags.
The Data Type selection field allows for the selection of one of the
following data types.
Unsigned Integer
Signed Integer
Hexadecimal
BCD (Binary-Coded-Decimal)
Binary (one word)
Float
The Format selection field allows for the selection of a display format for
the tag value. The available formats are dependent on the selected Data
Type.
The Low-limit entry field allows for the entering of a low limit for the tag
value. The operator is prohibited from entering values less than this limit.
The low limit is dependent on the selected Data Type.
The High-limit entry field allows for the entering of a high limit for the tag
value. The operator is prohibited from entering values greater than this
limit. The high limit is dependent on the selected Data Type.
The 1st-operation select fields define the first of two mathematical
functions that can be performed on the entered register tag data. Four
mathematical operands and an entered mathematical factor are available.
The range of valid mathematical factor values is dependent on the
selected Data Type. Selecting the NOP button cancels this feature.
The 2nd-operation select fields define the second of two mathematical
functions that can be performed on the entered register tag data. Four
mathematical operands and an entered mathematical factor are available.
The range of valid mathematical factor values is dependent on the
selected Data Type. Selecting the NOP button cancels this feature.
Tags:

Opens the Tags dialog.

The Ok command accepts the configuration and closes the dialog.
The Cancel command discards the configuration and closes the dialog.
The Help command displays the on-line help for the dialog.
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Display PLC Data
The Display PLC Data command defines a data display field on the
screen display. The data displayed in the field is either local SCADAPack
Vision register data or data read from the attached PLC.
Data can be displayed as either bit-based, register value-based or
register text-based data.
Bit-based data displays the contents of coil or input status tags in an ON
or OFF format.
Register value-based data displays the contents of input or holding
register tags in one of several numeric formats.
Register text-based data displays different text strings that are dependent
on the register value.
A maximum of 16 alphanumeric characters may be entered per line, for a
total of 32 characters per screen for SCADAPack Vision-10 or 20
alphanumeric characters per line, for a total of 80 characters per screen
for SCADAPack Vision-60.
Selecting this command activates the Display PLC Data cursor. This
cursor is used to point-and-drag a window in the screen display.
Defining the data display field location with the cursor opens the Display
Vision or PLC Data dialog.
This dialog defines the tag and data format to be associated with the data
display object. The Type is set to Bit Text by default.
Selecting the Bit Text radio button displays edit fields used to define a bitbased data display object.

The Coil-Tag selection field allows for the selection of a tag from a list of
all pre-defined bit-based tags.
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The Bit On Text edit field allows for the entering of a text string that is
displayed when the associated bit-based tag is ON. A maximum of 16
alphanumeric characters may be entered. The size of the pre-defined
point-and-drag window may also limit the length of the message.
The Bit Off Text edit field allows for the entering of a text string that is
displayed when the associated bit-based tag is OFF. A maximum of 16
alphanumeric characters may be entered. The size of the pre-defined
point-and-drag window may also limit the length of the message.
The Bit Text selection field allows for the selection of a tag from a list of
all pre-defined bit-based tags.
Selecting the Register Value radio button displays edit fields used to
define a register value-based data display object.

The Register-Value selection field allows for the selection of a tag from a
list of all pre-defined register-based tags.
The Data Type selection field allows for the selection of one of the
following data types.
Unsigned Integer
Signed Integer
Hexadecimal
BCD (Binary-Coded-Decimal)
Binary (one word)
Float
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The Format selection field allows for the selection of a display format for
the tag value. The available formats are dependent on the selected Data
Type.
The Low-limit entry field allows for the entering of a low limit for the tag
value. The operator is prohibited from entering values less than this limit.
The low limit is dependent on the selected Data Type.
The High-limit entry field allows for the entering of a high limit for the tag
value. The operator is prohibited from entering values greater than this
limit. The high limit is dependent on the selected Data Type.
The 1st-operation select fields define the first of two mathematical
functions that can be performed on the entered register tag data. Four
mathematical operands and an entered mathematical factor are available.
The range of valid mathematical factor values is dependent on the
selected Data Type. Selecting the NOP button cancels this feature.
The 2nd-operation select fields define the second of two mathematical
functions that can be performed on the entered register tag data. Four
mathematical operands and an entered mathematical factor are available.
The range of valid mathematical factor values is dependent on the
selected Data Type. Selecting the NOP button cancels this feature.
Selecting the Register Text radio button displays edit fields used to define
a register text-based data display object.
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The Register-Tag selection field allows for the selection of a tag from a
list of all pre-defined register-based tags.
Selecting the Add command displays edit fields used to define register
value ranges and their corresponding text messages.
The Low Limit entry field allows for the entering of the lower limit in a
range of register values. The low limit is dependent on the selected Data
Type.
The High Limit entry field allows for the entering of the higher limit in a
range of register values. The high limit is dependent on the selected Data
Type.
The Text entry field allows for the entering of a text string that is displayed
when the associated register-based tag contains a value within the low
and high limits. A maximum of 20 alphanumeric characters may be
entered for SCADAPack Vision-10 and 50 characters for SCADAPack
Vision-50 and Vision 60.
The configured low/high range and associated text string entries are
displayed in the list.
There is no limit to the number of low/high range and text entries
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Each low/high limit range must be unique and not overlap another.
The Accept command accepts the current configuration and adds it to the
list.
The Discard command discards the currently selected list entry.
Tags:

Opens the Tags dialog.

The Close command accepts the configuration and closes the dialog.
The Help command displays the on-line help for the dialog.
Bargraph
The Bargraph command defines a horizontally oriented bargraph that is
used to provide a visual representation of an analog signal based on a
configurable full-scale value.
A series of rectangular characters fill up the line of text in proportion to
percentage of full scale. For example, an 8-character bar graph,
corresponding to an analog input signal in the PLC, will display 8
rectangular characters for a full scale signal, 6 characters for 75% of full
scale signal, 4 characters for 50% of full scale signal etc.
The Bargraph object contains 8 rectangular characters and operates from
left to right only.
Selecting this command activates the Bargraph cursor. This cursor is
used to point-and-drag a window in the screen display.
Defining the bargraph field location with the cursor opens the Bar Graph
dialog.
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The Tag selection field allows for the selection of a tag from a list of all
pre-defined register-based tags.
The Min entry field defines the minimum limit for the bargraph object. The
value must be less than the Max value.
The Max entry field defines the maximum limit for the bargraph object.
The value must be greater than the Min value and less than 65535.
The Direction of operation is fixed at Left to Right and cannot be changed.
Tags:

Opens the Tags dialog.

The Ok command accepts the configuration and closes the dialog.
The Cancel command discards the configuration and closes the dialog.
The Help command displays the on-line help for the dialog.
Alarm
The Alarm command defines an alarm-display object. This object can
display any pre-defined alarm as soon as it is triggered.
All triggered alarms are listed in a FIFO (First in First Out) queue. A
maximum of 31 alarms may be in the FIFO queue. The first alarm will be
at the top of the FIFO queue with the newest alarm entering from the
bottom. A triggered alarm will remain in the FIFO queue until the alarm
condition ceases to exist and the alarm has been operator-acknowledged.
Each alarm must be acknowledged at some time. Alarms are
acknowledged by using keys that have been defined with the
Acknowledge Alarm option in the Key’s Specific Task command.
Alarms displayed in the FIFO queue may be scrolled through by using
keys that have been defined with the Next Alarm and Previous Alarm
options in the Key’s Specific Task command.
The alarm-display object displays alarm information in a series of
columns and may contain up to a maximum of 16 alphanumeric
characters per line for SCADAPack Vision-10 and 20 alphanumeric
characters per line for SCADAPack Vision-60.
Selecting this command activates the Alarm cursor. This cursor is used to
point-and-drag a window in the screen display. To maximize the amount
of alarm information that can be displayed, create an alarm display field
that is the entire width of the display, i.e. 16 or 20 characters long.
Defining the alarm field location with the cursor opens the Alarm dialog.
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The Select From list displays the available types of alarm information that
can be used to display triggered alarms. The four types are:
Alarm Text: Displays the text message associated with the alarm. If an
alarm condition is true, the alarm text is displayed. If the alarm condition
is false, a blank space is displayed.
Number: Displays the alarm number. If an alarm condition is true, the
alarm number is displayed. If the alarm condition is false, ?? is displayed.
Active:
Displays the active status. If an alarm condition is true,
the active alarm status displays yes. If the alarm condition is false the
active alarm status displays no.
Acknowledged: Displays the acknowledged status. If an alarm condition
is true and the alarm has been acknowledged, the acknowledged alarm
status displays yes. If an alarm condition is true and the alarm has not yet
been acknowledged, or the alarm condition is false, the acknowledged
alarm status displays no.
The Add command moves selected items from the Select From list to the
Selected list.
The Delete command removes selected items from the Selected list to
the Select From list.
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The Up command moves the selected item in the Selected list up one
row.
The Down command moves the selected item in the Selected list down
one row.
The Selected list contains the alarm information that is displayed in the
alarm-display object. Items in this list will be displayed in the order that
they are listed.
The Length entry field defines the length of the text message to be
displayed. The field is available when Alarm Text is highlighted in the
Selected list.
The Active radio buttons define how the active alarm status is displayed.
The status can be displayed as either Y/N or Yes/No. The radio buttons
are available when Active is highlighted in the Selected list.
The Acknowledged radio buttons define how the acknowledged alarm
status is displayed. The status can be displayed as either Y/N or Yes/No.
The radio buttons are available when Acknowledged is highlighted in the
Selected list.
The Ok command accepts the configuration and closes the dialog.
The Cancel command discards the configuration and closes the dialog.
The Help command displays the on-line help for the dialog.
It is important that the total number of selected alarm-parameter
characters and column spaces does not exceed the width of the
configured alarm window. Undefined display behavior may occur.
Flash
The Flash command enables the flashing capability of selected data
entry, text, and bargraph objects.
Speed
The Speed command defines the flash rate properties of data entry, text,
and bargraph objects. Three flash rates are available: slow, medium and
fast.
Animation Properties
The Animation Properties command defines the conditional show/hide
and flash rate properties of data entry, text, and bargraph objects. Objects
can be defined to show/hide or flash depending on the value of a tag.
Selecting the Animation Properties command opens the Animation
Properties dialog.
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Show/Hide
The Show/Hide fields define the conditions under which an object will be
shown or hidden, conditional upon the value of a tag.
The Show/Hide check box enables the Show/Hide option.
The Tag entry field allows for the selection of the pre-defined tag.
The Show when radio buttons define if the object is to be shown when the
bit-based tag is On or Off, or when the register-based tag is Within or Out
of the defined range.
The Range entry boxes define the Low and High register-based tag
values for the Show/Hide condition.
Flash
The Flash fields define the conditions, under which an object will flash,
conditional upon the value of a tag.
The Flash check box enables the Flash option. The rate of flash is
selected in the field to the right of the Flash check box.
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The Tag entry field allows for the selection of the pre-defined tag.
The Flash when radio buttons define if the object is to flash when the bitbased tag is On or Off, or when the register-based tag is Within or Out of
the defined range.
The Range entry boxes define the Low and High register-based tag
values for the Flash condition.
The Ok command accepts the configuration and closes the dialog.
The Cancel command discards the configuration and closes the dialog.
The Help command displays the on-line help for the dialog.
Tags:

Opens the Tags dialog.

Selector
The Selector command enables the selector cursor to select objects on
the display screen.
Hide Objects Menu
The Hide Objects Menu command hides the Objects and Properties
dialog. This command is available only when the Show Objects Menu
command is currently active.
Show Objects Menu
The Show Objects Menu command shows the Objects and Properties
dialog. This command is available only when the Hide Objects Menu
command is currently active.

Tools Menu
The Tools menu contains commands to undo/redo commands and cut,
copy, paste and edit screen display objects.
Undo
The Undo command un-does the last command.
Redo
The Redo command un-does the last Undo command.
Select All
The Select All command selects all objects on the currently open display
screen.
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Cut
The Cut command removes the currently selected object from the display
screen and places it in the computer’s buffer memory for later insertion.
Copy
The Copy command copies the currently selected object from the display
screen and places it in the computer’s buffer memory for later insertion.
Paste
The Paste command inserts the object previously saved in the computer’s
buffer memory to the screen display.
Edit
The Edit command opens the edit dialog for the currently selected object.
Hide Tools
The Hide Tools command hides the Tools dialog. This command is
available only when the Tools command is currently active.
Show Tools
The Show Tools command displays the Tools dialog. This command is
available only when the Hide Tools command is currently active.

Help
The Help menu allows access to the SCADAPack Vision program on line
help.
Index
The Index command opens the Vision Configuration Software Help index.
Help is available on the following topics:
The Introduction provides an overview of the SCADAPack Vision
configuration software.
Screen Elements describes individual parts of the SCADAPack Vision
configuration software as well as basic concepts.
The Essentials describes how to quickly create a new application.
Menus describes individual menus and their associated commands.
Dialogs describes all secondary screen dialogs.
Technical Support provides Control Microsystems’ contact numbers and
addresses.
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About Vision Configuration Software provides release history, notes, and
copyright information.
About SCADAPack Vision Series
The About SCADAPack Vision Series command displays program
version information.

Key Task Definitions
Individual keys can be configured to function in a variety of ways. The
following is a list of supported key task definitions. Definitions not listed
below are not supported by the SCADAPack Vision and cannot be used.
Goto Screen: The current screen is replaced by the defined screen.
Goto Next Screen: The current screen is replaced by the next sequential
screen.
Goto Previous Screen: The current screen is replaced by the previous
sequential screen.
Write Value to a Tag: A constant value is written to the tag using this task.
Add a Constant Value to Tag: A constant value is added to the current
value of the tag using this task.
Subtract a Constant Value from Tag: A constant value is subtracted from
the current value of the tag using this task.
Add Tag B to Tag A: The value of Tag B is added to the value of Tag A.
The result will be stored in Tag A. Both tags must contain the identical
number of bytes otherwise errors may occur.
Subtract Tag B from Tag A: The value of Tag B is subtracted from the
value of Tag A. The result will be stored in Tag A. Both tags must contain
the identical number of bytes otherwise errors may occur.
Turn Bit On: A coil or bit is turned on.
Turn Bit Off: A coil or bit is turned off.
Toggle Bit: A currently off coil or bit is turned on; a currently on coil or bit
is turned off.
Copy Tag B to Tag A: The value of Tag B is copied to Tag A. The value of
Tag B is unchanged. Both tags must contain the identical number of bytes
otherwise errors may occur.
Swap Tag A and Tag B: The value of Tag A is copied to Tag B and the
value of Tag B is copied to Tag A. Both tags must contain the identical
number of bytes otherwise erroneous results may occur.
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Copy Tag to STR: A PLC tag can be copied to the STR, Screen
Triggering Register. The STR is an internal SCADAPack Vision register,
which can be used to decide which screen is to be displayed.
Copy Tag to LED: The value of a tag is copied to the SCADAPack Vision
LEDs.
Delay: The execution of a task is delayed. Tags are updated during this
delay. After the delay period is expired, the next task is performed.
Wait: The execution of a Task is conditionally delayed. The next task is
not executed until the specified condition is false.
Key’s Specific Task: In addition to the previously described tasks, each
key can be assigned a task that is common to all tags. The types of keyspecific tasks are:
Clear Data Entry: Clears Data after data entry is initiated.
Cancel Data Entry: Cancels the data entered and restores previous data.
Accept Data Entry: Initiates data entry and accepts data entered.
Switch to next Data Entry: Next data entry is selected.
Increase Value by 1: Value of a tag is increased by 1.
Decrease Value by 1: Value of a tag is decreased by 1.
Increase Digit by 1: Value of a single digit of a tag is increased by 1.
Decrease Digit by 1: Value of a single digit of a tag is decreased by 1.
Shift Value to Left: Value is shifted to left.
Move Cursor to Left: Cursor is moved to left to edit previous digit.
Move Cursor to Right: Cursor is moved to right to edit next digit.
Sign Key (+/-): Used for signed data entry.
Sign Key (+/-) and 0: Single key used as a sign key as well as numeric
key 0. If this key is pressed immediately after data entry is initiated, key is
taken as sign key else it is taken as ‘0’ key.
Numeric Key 0: Enters a ‘0’ after data entry is initiated.
Numeric Key 1: Enters a ‘1’ after data entry is initiated.
Numeric Key 2: Enters a ‘2’ after data entry is initiated.
Numeric Key 3: Enters a ‘3’ after data entry is initiated.
Numeric Key 4: Enters a ‘4’ after data entry is initiated.
Numeric Key 5: Enters a ‘5’ after data entry is initiated.
Numeric Key 6: Enters a ‘6’ after data entry is initiated.
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Numeric Key 7: Enters a ‘7’ after data entry is initiated.
Numeric Key 8: Enters a ‘8’ after data entry is initiated.
Numeric Key 9: Enters a ‘9’ after data entry is initiated.
Numeric Key A: Enters an ‘A’ after data entry is initiated.
Numeric Key B: Enters a ‘B’ after data entry is initiated.
Numeric Key C: Enters a ‘C’ after data entry is initiated.
Numeric Key D: Enters a ‘D’ after data entry is initiated.
Numeric Key E: Enters a ‘E’ after data entry is initiated.
Numeric Key F: Enters a ‘F’ after data entry is initiated.
Edit Bit On: A coil is turned on after data entry is initiated.
Edit Bit Off: A coil is turned off after data entry is initiated.
Acknowledge Alarm: Active alarm is acknowledged.
Next Alarm: Next alarm from the alarm FIFO queue is displayed.
Previous Alarm: Previous alarm from the alarm FIFO queue is displayed.
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Warranty Disclaimer
Control Microsystems makes no representation or warranty with respect
to the SCADAPack Vision program. The sole obligation of Control
Microsystems shall be to make available all published updates or
modifications to the Vision program at a price, which will not exceed the
current market price.
Limitation of Liability
The foregoing warranty is in lieu of all other warranties, expressed or
implied, including but not limited to, the implied warranties of
merchantability and fitness for a particular purpose. The user shall, at
their own discretion, determine the suitability of the SCADAPack Vision
program for their intended use. In no event will Control Microsystems, its
agents, distributors, representatives, employees, officers, directors, or
contractors be liable for any special, direct, indirect or consequential
damages, losses, costs, claims, demands or claim for lost profits, fees or
expenses of any nature or kind arising from the use of the SCADAPack
Vision program. In accepting this product, you agree to these terms.
Modifications
Control Microsystems reserves the right to make modifications to the
SCADAPack Vision program and to change its specifications without
notice.
Non-Disclosure
SCADAPack and SCADAPack Vision are registered trademarks of
Control Microsystems. The SCADAPack Vision program is a copyrighted
product of Control Microsystems. Users are specifically prohibited from
copying the SCADAPack Vision program, in whole or in part, by any
means whatsoever, except for purposes of a backup copy, and from
disclosing proprietary information belonging to Control Microsystems.
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Disclaimer: Control Microsystems reserves the right to change product
specifications without notice. For more information visit
www.controlmicrosystems.com .
Power:

5 VDC+ 5%.
100mA typical

Power Saving Mode: With SCADAPack LP only.
Display:

Backlit LCD.

2 lines of 16 characters.
Bezel:

IP65 rated Keypad

Function Keys:

6 user-definable keys with tactile feedback.

Status LEDs:

2 user-definable LEDs.

Memory:

24K Application Memory.

Communication:

Two RS232 ports:

SCADAPack Vision-10 to PLC (for PLC data reading/writing).
SCADAPack Vision-10 to computer (for application/firmware downloads).
Environment:
Temperature: Vision-10
Operating Temp.:

0 to 60 ºC. / 32 to 140 ºF.

Storage Temp.:

-25 to 80 ºC. / -13 to 176 ºF.

Vision-10+70
Operating Temp.:

0 to 70 ºC. / 32 to 158 ºF.

Storage Temp.:

-25 to 80 ºC. / -13 to 176 ºF.

Humidity:

10% to 90% (Non condensing).

Area Classification: UL Class 1 Division 2, Groups A, B, C and D for
use in hazardous locations.
Immunity to ESD:

Level 3 as per IEC1000-4-2

Immunity to Transients:
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Radiated Susceptibility:
Emissions:

Level 3 as per IEC1000-4-3

EN55011 CISPR A
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Disclaimer: Control Microsystems reserves the right to change product
specifications without notice. For more information visit
www.controlmicrosystems.com .
Power:

5 VDC+ 5%.
160mA typical

Power Saving Mode: With SCADAPack LP only.
Display:
Bezel:

Backlit LCD, 4 lines of 20 characters.
IP65 rated Keypad

Function Keys:

20 user-definable keys with tactile feedback.

Status LEDs:

8 user-definable LEDs.

Memory:

24K Application Memory.

Communication:

Two RS232 ports:

SCADAPack Vision-50 to PLC (for PLC data reading/writing).
SCADAPack Vision-50 to computer (for application/firmware downloads).
Environment:
Temperature:

Vision-50

Operating Temperature: 0 to 60 ºC. / 32 to 140 ºF.
Storage Temperature: -25 to 80 ºC. / -13 to 176 ºF.
Vision-50+70
Operating Temperature: 0 to 70 ºC. / 32 to 158 ºF.
Storage Temperature: -25 to 80 ºC. / -13 to 176 ºF.
Humidity:

10% to 90% (Non condensing).

Area Classification: UL Class 1 Division 2, Groups A, B, C and D for
use in hazardous locations.
Immunity to ESD:

Level 3 as per IEC1000-4-2

Immunity to Transients:

Level 3 as per IEC1000-4-4

Radiated Susceptibility:

Level 3 as per IEC1000-4-3
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Emissions:

EN55011 CISPR A
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Disclaimer: Control Microsystems reserves the right to change product
specifications without notice. For more information visit
www.controlmicrosystems.com .
Power:

5 VDC+ 5%.
185mA typical

Power Saving Mode: With SCADAPack LP only.
Display:

Backlit LCD.

4 lines of 20 characters.
Bezel:

IP65 rated Keypad

Function Keys:

20 user-definable keys with tactile feedback.

Status LEDs:

8 user-definable LEDs.

Memory:

128K Application Memory.

Communication:

Two RS232 ports:

SCADAPack Vision-60 to PLC (for PLC data reading/writing).
SCADAPack Vision-60 to computer (for application/firmware downloads).
Environment:
Temperature:

Vision-60

Operating Temperature: 0 to 60 ºC. / 32 to 140 ºF.
Storage Temperature: -25 to 80 ºC. / -13 to 176 ºF.
Vision-60+70
Operating Temperature: 0 to 70 ºC. / 32 to 158 ºF.
Storage Temperature: -25 to 80 ºC. / -13 to 176 ºF.
Humidity:

10% to 90% (Non condensing).

Area Classification: UL Class 1 Division 2, Groups A, B, C and D for
use in hazardous locations.
Immunity to ESD:

Level 3 as per IEC1000-4-2

Immunity to Transients:
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Radiated Susceptibility:
Emissions:

Level 3 as per IEC1000-4-3

EN55011 CISPR A
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